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Legal Information
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under the terms of which the equipment to which this manual relates was acquired.
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IMPORTANT:
Before operating or maintaining this unit, please read this manual carefully paying extra attention to the safety 
warnings and precautions.

Manuals / Technical Documentation - The information in this manual is periodically revised to ensure the latest 
information is included. Download the latest version of this manual and other related technical documentation from 
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Contact Information (United Kingdom) 
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Regulatory Information
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or a later version of the same standard incorporating the same level of testing requirements.
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Safety Information

READ ALL INSTRUCTIONS
For your own safety, the safety of others, and to prevent damage to the product and vehicles upon 
which it is used, it is important that all instructions and safety messages in this manual and the 
accompanying Important Safety Instructions manual be read and understood by all persons 
operating, or coming into contact with the product, before operating. We suggest you store a copy 
of each manual near the product in sight of the operator.

For your safety, read all instructions. Use your diagnostic tools only as described in the tool user’s 
manual. Use only manufacturer recommended parts and accessories with your diagnostic tools.

This product is intended for use by properly trained and skilled professional automotive 
technicians. The safety messages presented throughout this manual and the accompanying 
Important Safety Instructions manual are reminders to the operator to exercise extreme care when 
using this product.

There are many variations in procedures, techniques, tools, and parts for servicing vehicles, as 
well as in the skill of the individual doing the work. Because of the vast number of test applications 
and variations in the products that can be tested with this instrument, we cannot possibly 
anticipate or provide advice or safety messages to cover every situation. It is the responsibility of 
the automotive technician to be knowledgeable of the system being tested. It is essential to use 
proper service methods and test procedures. It is important to perform tests in an appropriate and 
acceptable manner that does not endanger your safety, the safety of others in the work area, the 
equipment being used, or the vehicle being tested.

It is assumed that the operator has a thorough understanding of vehicle systems before using this 
product. Understanding of these system principles and operating theories is necessary for 
competent, safe and accurate use of this instrument.

Before using the equipment, always refer to and follow the safety messages and applicable test 
procedures provided by the manufacturer of the vehicle or equipment being tested. Use the 
product only as described in it’s user manual. Use only manufacturer recommended parts and 
accessories with your product.

Read, understand and follow all safety messages and instructions in this manual, the 
accompanying Important Safety Instructions manual, and on the test equipment.

Environmental Conditions:

• This product is intended for indoor use only

• This product is rated for Pollution Degree 2 (normal conditions)
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Safety Information Safety Signal Words

Safety Signal Words
All safety messages contain a safety signal word that indicates the level of the hazard. An icon, 
when present, gives a graphical description of the hazard. Safety Signal words are:

Indicates an imminently hazardous situation which, if not avoided, will result in death or serious 
injury to the operator or to bystanders.

Indicates a potentially hazardous situation which, if not avoided, could result in death or serious 
injury to the operator or to bystanders.

Indicates a potentially hazardous situation which, if not avoided, may result in moderate or minor 
injury to the operator or to bystanders.

Safety Message Conventions
Safety messages are provided to help prevent personal injury and equipment damage. Safety 
messages communicate the hazard, hazard avoidance and possible consequences using three 
different type styles:

• Normal type states the hazard.

• Bold type states how to avoid the hazard.

• Italic type states the possible consequences of not avoiding the hazard.

An icon, when present, gives a graphical description of the potential hazard.

Safety Message Example

Risk of unexpected vehicle movement.

• Block drive wheels before performing a test with engine running.

A moving vehicle can cause injury.

Important Safety Instructions
For a complete list of safety messages, refer to the accompanying Important Safety Instructions 
manual.

SAVE THESE INSTRUCTIONS
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Chapter 1 Using This Manual

This manual contains basic operating instructions and is structured in a manner to help you 
become familiar with your diagnostic tool features and perform basic operations.

The illustrations in this manual are intended as reference only and may not depict actual screen 
results, information, functions or standard equipment. Contact your sales representative for 
availability of other functions and optional equipment. 

1.1   Conventions

1.1.1  Bold Text

Bold emphasis is used in procedures to highlight selectable items such as buttons and menu 
options.

Example:

• Select Functions.

1.1.2  Symbols

The “greater than” arrow (>) indicates an abbreviated set of selection instructions.

Example:

• Select Utilities > Tool Setup > Date.

The above statement abbreviates the following procedure:

1. Select the Utilities icon.

2. Select the Tool Setup submenu.

3. Highlight the Date option from the submenu.

1.1.3  Terminology
The term “select” describes tapping/touching an icon on the touch screen, or highlighting an icon 
or menu choice and then selecting the confirmation menu choice such as Continue, Accept, OK, 
Yes, or other similar choice.

Example:

• Select Reset.

The above statement abbreviates the following procedure:

1. Navigate to the Reset icon.

2. Select the Reset icon with your stylus.
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Using This Manual Conventions

1.1.4  Notes and Important Messages

The following messages are used.

Note

A note provides helpful information such as additional explanations, tips, and comments.

Example:

NOTE:
i For additional information refer to...

Important

Important indicates a situation which, if not avoided, may result in damage to the test equipment 
or vehicle.

Example:

IMPORTANT:
Disconnecting the USB cable during vehicle communication can cause damage to the ECM.

1.1.5  Procedures

An arrow icon indicates a procedure.

Example:

z To change screen views:

1. Select View.

The dropdown menu displays.

2. Select an option from the menu.

The screen layout changes to the format you selected.

1.1.6  Hyperlinks
Hyperlinks, or links, that take you to other related articles, procedures, and illustrations are 
available in electronic documents. Blue colored text indicates a selectable hyperlink.

Example:

IMPORTANT:
Read all applicable Safety Information before using this tool!

1.1.7  Tool Help

To display help topics for this tool, select a help option from the Help menu.
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Chapter 2 Introduction

This chapter introduces the basic features of the Diagnostic Tool, including the control buttons, 
data ports, battery pack, and power sources. Your Diagnostic Tool is a specialized personal 
automotive diagnostic solution that combines information with test instrumentation to help you 
diagnose symptoms, codes, and complaints quickly and efficiently. There are basically two main 
components to the VERUS® Diagnostic Tool:

• Diagnostic Tool—the central processor and system monitor with integral scope.

• Scan Module (Wireless) (wireless models) — wireless device for accessing vehicle data.

This manual describes the operation of these devices and how they work together to deliver 
diagnostic solutions.

There are two versions of the VERUS Diagnostic Tool: (operation and function are similar for both) 

Standard Version

On early-model VERUS Diagnostic Tools the Scanner is built (integrated) into the Diagnostic Tool. 
During scanner testing, the data cable is connected directly from the Diagnostic Tool to the data 
link connector on the vehicle.

Wireless Version

On later-model VERUS Diagnostic Tools the Scanner (referred to as a Scan Module) is a separate 
unit that communicates wirelessly with the Diagnostic Tool. During scanner testing, the data cable 
is connected directly from the Scan Module to the data link connector on the vehicle.

IMPORTANT:
Earlier standard Diagnostic Tools can be converted to operate with the wireless Scan Module, 
contact your sales representative for details. 
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Introduction Features and Specifications

2.1   Features and Specifications

2.1.1  Diagnostic Tool

1— Audio Speaker

2— Touch Screen Display

3— Microphone

4— S (Shortcut) Button

5— Virtual Keyboard Button

6— Brightness Up Button

7— Brightness Down Button

8— Hard Drive Activity LED

9— Wireless LAN Activity LED

10—Battery Charging LED

11—Main Power LED

12—Power Button
Figure 2-1 Front view
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Introduction Features and Specifications

Standard Version (Early-Models)

1— VGA (video graphics array) Connector

2— LAN (local area network) Jack

3— USB (universal serial bus) Jack

4— Audio (head phone) Jack

5— DC Power Supply Input Jack

6— Fan Filter

7— Data Cable Connector

8— Scope Auxiliary Connector

9— Channel 4 Jack

10—Channel 3 Jack

11—Channel 2 Jack

12—Channel 1 Jack

13—Common Ground Jack
Figure 2-2 Top view, standard model
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Introduction Features and Specifications

Wireless Version (Later-Models)

1— VGA (video graphics array) Connector

2— LAN (local area network) Jack

3— USB (universal serial bus) Jacks (2)

4— Audio (head phone) Jack

5— DC Power Supply Input Jack

6— Fan Filter

7— Scope Auxiliary Connector

8— Channel 4 Jack

9— Channel 3 Jack

10—Channel 2 Jack

11—Channel 1 Jack

12—Common Ground Jack
Figure 2-3 Top view, wireless model
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Introduction Features and Specifications

2.1.2  Technical Specifications

2.1.3  Built-in Stand

The Diagnostic Tool has a built-in, metal stand attached to the back. When the stand is not in use, 
it is secured to the back of the Diagnostic Tool by an integrated casing hook. When extended, the 
stand allows the Diagnostic Tool to rest at a 45° angle for hands-free viewing.

2.1.4  Wrist Strap (Optional)

An adjustable wrist strap that attaches to the back of the Diagnostic Tool to secure and stabilize 
the Diagnostic Tool while you work is available as an option. Using the wrist strap allows the 
Diagnostic Tool to comfortably rest on your forearm and leaves a hand free for connecting test 
leads and operating the touch screen. The strap also eliminates the possibility of the Diagnostic 

Item Description / Specification

Touch Screen 5-Wire Resistive Touch Panel

Display
10.4 inch, outdoor enhanced, TFT LCD

1024 x 768 resolution, 262,144 Colors

Processor
Standard: 600MHz Intel Celeron M
WIreless: Intel Atom 1.6GHz

Operating System Microsoft Windows Embedded Standard XPe SP3

Communications

802.11 b/g/n Wireless

Wireless Bluetooth® 2.0 Technology

10/100 Ethernet Jack

Memory
Standard: 500MB RAM

Wireless: 1GB RAM

Battery

Lithium Ion Smart Battery Pack

Approximate 4 hour run time

Approximate 4 hour charge time (unit operating)

Approximately 8 hour charge time, (unit not operating)

Power Supply Supply Rating; 12–17 VDC. 3.53A

DC Operating Voltage 17VDC 60W, LPS (limited power source) 

Width 14.9 in. (358 mm)

Height 9.17 in. (233 mm)

Depth 3.07 inches (78 mm)

Weight (including 
battery)

7.5 lb (3402 g)

Operating Temperature 
Range (ambient)

At 0 to 90% relative humidity (non-condensing) 
32 to 113°F (0 to 45°C)

Storage Temperature 
(ambient)

At 0 to 70% relative humidity (non-condensing) 
–4 to 131°F (–20 to 55°C)

Operating Altitude Maximum 2000 m

Environmental 
Conditions

This product is intended for indoor use only

This product is rated for Pollution Degree 2 (normal conditions)
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Introduction Features and Specifications

Tool falling off a vehicle due to vibrations or other movement, and also prevents you from 
accidentally dropping the Diagnostic Tool.

2.1.5  Power Conservation

To conserve power, the Diagnostic Tool uses a power saving strategy when left idle. Standby 
mode engages following a period of inactivity. During standby, the random access memory (RAM) 
remains powered, but all other functions are turned off. The screen shuts off and the Main Power 
LED remains illuminated when in standby mode.

NOTE:
i The Standby mode characteristics can be configured by selecting Power Options from the 

Windows Control Panel menu.

2.1.6  Power Sources

Your Diagnostic Tool can receive power from any of the following sources:

• Internal Battery Pack

• Docking Station (Optional)

• AC/DC Power Supply

• Vehicle Power

Internal Battery Pack

The Diagnostic Tool can be powered from a rechargeable lithium ion battery located on the bottom 
of the Diagnostic Tool under the right handgrip (Figure 2-5). A fully charged battery provides 
sufficient power for about four hours of constant operation.

1— Internal Battery Pack

2— Right Handgrip
Figure 2-4 Battery pack location

The battery is recharged on demand whenever the Diagnostic Tool is placed in the optional 
docking station, or the AC/DC power supply is connected to a voltage source.
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Docking Station (Optional)

The Diagnostic Tool can be powered and operated when installed on the optional docking station. 
The docking station also powers the internal battery pack charging process and allows USB 
connectivity for attaching peripherals. Contact your sale representative for additional details.

AC/DC Power Supply

The Diagnostic Tool can be powered from a wall socket using the AC/DC power supply and power 
cord. The AC/DC power supply also powers the internal battery pack charging process.

Vehicle Power

The standard Diagnostic Tool can be powered through the DLC when connected to an OBD-II 
vehicle with the data cable. However, battery pack charging is not available when the Diagnostic 
Tool is being powered by the DLC.



10

Introduction Scan Module (Wireless)

2.2   Scan Module (Wireless)
The wireless Scan Module is provided as standard equipment on all late-model VERUS 
Diagnostic Tools. Early VERUS Diagnostic Tools, which are designed to operate with a cable 
connection to the test vehicle, can also be converted to operate with the wireless Scan Module.

2.2.1  Functional Description

1— Data cable connector

2— Memory card port (remove protective hand grip for access)

3— Bluetooth LED (green)

4— Communication issue LED (red)

5— Vehicle power LED (green)

6— Universal serial bus (USB) jack (remove protective hand grip for access)
Figure 2-5 Scan Module

Wireless Communication

The wireless Scan Module is a communication device that transmits vehicle data to the Diagnostic 
Tool without a physical connection. The working range of the transmitter is about 30 feet (9.14 m). 
A signal lost due to moving out of range automatically restores itself when the Diagnostic Tool is 
brought closer to the Scan Module. The Scan Module sounds a tone and the Diagnostic Tool 
shows a warning message when the signal is lost.
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Introduction Scan Module (Wireless)

2.2.2  Technical Specifications

2.2.3  Power Sources

The Scan Module operates on 12V or 24V vehicle power, which it receives through the data cable 
connector. The Scan Module powers on whenever it is connected to an OBD-II/EOBD compliant 
data link connector (DLC). For non OBD-II/EOBD compliant vehicles, the Scan Module can be 
powered from a suitable power port on the test vehicle using the auxiliary power cable supplied 
with your kit.

Item Description / Specification

Communications Wireless Bluetooth® 2.0 Technology

USB Power 5V @ 500mA

Data Cable Connector 
Power

8V to 32V, Maximum 12 Watts

Width 8.04 in. (204.3 mm)

Height 3.82 in. (97 mm)

Depth 1.66 in. (42.1 mm)

Weight 0.9 lb (0.408 kg)

Operating Temperature 
Range (ambient)

At 0 to 90% relative humidity (non-condensing) 
32 to 113°F (0 to 45°C)

Storage Temperature 
(ambient)

At 0 to 70% relative humidity (non-condensing) 
–4 to 140°F (–20 to 60°C)

Operating Altitude Maximum 2000 m

Environmental 
Conditions

This product is intended for indoor use only

This product is rated for Pollution Degree 2 (normal conditions)
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Chapter 3 Basic Operation and 
Navigation

This chapter describes the basic operation, controls and navigation of the diagnostic tool. 

3.1   Turning On/Off and Emergency Shutdown
The following sections describe how to turn the diagnostic tool on and off and how to perform an 
emergency shutdown.

Before using the diagnostic tool, make sure the battery is fully charged or is connected to an
AC/DC power supply. see “Power Sources” on page 8. 

3.1.1  Turning On

Press the diagnostic tool Power button to switch the diagnostic tool on. The system boots up, then 
opens the Home screen (Figure 3-2).

3.1.2  Turning Off 

All vehicle communication must be terminated before shutting down the diagnostic tool. A warning 
message displays if you attempt to shut down while the diagnostic tool is communicating with a 
vehicle. Forcing a shut down while communicating may lead to ECM problems on some vehicles. 
Exit the Scanner function before turning off.

Before turning the diagnostic tool off, it is highly recommended to back up personal and saved 
data to a USB mass storage device on a regular basis to prevent loss in the event of system 
corruption or hard disk drive failure

z To turn off the diagnostic tool:

1. Navigate to the Home screen.

2. Select the Exit icon.

3. From the Windows desktop, open the Windows Start menu.

4. Select Turn Off Computer.

5. Select Turn Off in the dialog box.

The open programs close and the power turns off.

3.1.3  Emergency Shutdown

In case of emergency, press and hold the Power button for 5 seconds to force a shutdown.
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3.2   Controls and Indicators
The external controls on the diagnostic tool are simple because most operations are controlled 
through the touch screen. Touch screen navigation is menu driven, which allows you to quickly 
locate the test, procedure, or data that you need through a series of choices and questions. 
Detailed descriptions of the menu structures are found in the chapters for the various modules.

The following sections describe the external controls and features of the diagnostic tool.

3.2.1  Control Buttons

There are five control buttons located on the right side of the diagnostic tool near the handgrip:

All other diagnostic tool operations are controlled through the touch screen.

S (Shortcut) Button

Use the S Button to quickly capture an image of the current screen with a single button press. This 
screen capture function is available at all times, even when operating outside of the VERUS 
diagnostic tool software.

3.2.2  LEDs

The four light-emitting diodes indicate certain system conditions:

• Hard Drive Activity LED—illuminates when the central processing unit (CPU) is reading or 
writing to the hard disk drive (HDD).

• Wireless LAN Activity LED—illuminates when a wireless local area network (LAN) in enabled, 
flashes when data is being sent or received.

• Battery Charging LED—illuminates when the internal battery pack is charging.

• Main Power LED—illuminates when the diagnostic tool is powered on or in Standby mode.

Name Button Description

S (Shortcut) Button
A function button that provides a shortcut for 
performing routine tasks.

Keyboard
Opens, and closes, a virtual keyboard on the 
touch screen.

Brightness Up
Incrementally increases the screen 
backlighting.

Brightness Down
Incrementally decreases the screen 
backlighting.

Power
Turns the diagnostic tool on and off. Also, press 
and hold for 5 seconds for emergency 
shutdown.
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3.3   Basic Navigation

3.3.1  Starting the ShopStream Diagnostic Suite Program

The ShopStream Diagnostic Suite program is automatically started when the diagnostic tool is 
turned on through the Windows “start up” folder function. After the program has started, the 
ShopStream Diagnostic Suite Home Screen displays, see “Home Screen Layout” on page 14. 
The application runs as a normal Windows program and it’s window can be minimized, resized 
and closed like any other Windows program. To access the Windows desktop, minimize the 
program window. 

If the program is exited or closed, select the ShopStream Diagnostic Suite icon from the Windows 
desktop to start the program.

Figure 3-1 ShopStream Diagnostic Suite desktop icon

NOTE:
i The ShopStream Diagnostic Suite can also be started from the Windows Start menu.

3.3.2  Home Screen Layout

The Home screen includes the diagnostic suite toolbar and the Windows toolbar. The Home 
screen includes function icons, one for each of the primary diagnostic tool functions.

1— Function Icons

2. Toolbar

3. Windows Toolbar
Figure 3-2 Sample Home screen
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3.3.3  Function Icons

The Function Icons configure the diagnostic tool for the type of test to be performed. Table 3-1 
gives brief descriptions of the available icons, which operations are available depends upon the 
individual configuration of your system. Use the stylus or your finger tip to select from the icons.

Table 3-1 

Name Icon Description

Scanner
Configures the diagnostic tool to operate as 
a scan tool. See “Scanner Operations” on 
page 20.

OBD Direct

Allows you to perform generic OBD-II or 
EOBD system tests without identifying the 
specific vehicle. See “OBD Direct 
Operations” on page 67.

Guided Component 
Test

Opens a diagnostic database of specific 
tests for the identified vehicle. See “Guided 
Component Test Operations” on page 75.

Scope Multimeter

Configures the diagnostic tool to operate as 
a lab scope, graphing multimeter, or digital 
multimeter. See “Scope Multimeter” on 
page 86.

Information

Provides the information needed to make 
repairs once you have made your 
diagnosis. The linked program varies by 
region. See “Information” on page 111.

Vehicle History

Identifies the test vehicle and organizes and 
manages work in progress and service 
records. See “Vehicle History Operations” 
on page 123.

Data Manager
Opens the organization system for saved 
data files. See “Data Manager Operations” 
on page 129.

Help
Opens the on-line help for the system. See 
“Help Operations” on page 154.

System Settings
Establishes and manages connections to 
peripheral devices. See “System Settings 
Operations” on page 155.

Exit
Closes the diagnostic tool software and 
returns the display to the Windows desktop. 
See “Turning Off” on page 12.
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3.3.4  Toolbar

Operation of the icons located on the toolbar are described in the table below:

Menu Options

The Menu icon on the Toolbar at the base of the display screen opens a list of basic operations 
and features. The list of options varies depending upon which module, or tool function, is active. 
Selecting a menu item opens a submenu of choices, and some submenus also open an additional 
menu. A right arrowhead () indicates additional choices are available. Touch an item to select 
it. The following Menu options are available from the Home Screen:

• Safety Information—opens the Important Safety Instructions document.

• Help—allows you to view supporting documentation, selecting opens a submenu.

Safety Information

Selecting Safety Information opens a PDF copy of the Important Safety Instructions that are 
included in your diagnostic tool kit. The Important Safety Instructions document should be read 
and understood prior to using the diagnostic tool.

Help

A variety of utilities and additional resources are available through the Help menu. Basic menu 
options, which are available for all modules, include:

• User Manual

• Version Info

• Activation Status

Table 3-2 

Name Icon Description

Home
Selecting this icon returns you to the Home 
screen from any test.

Desktop

Selecting this icon opens and closes the 
standard Windows toolbars at the top and 
bottom of the screen, which allow you 
access to the Windows desktop.

Menu
Selecting this icon opens a menu that 
provides information and basic operations 
and features for the current screen.

Change Vehicle
The currently identified vehicle is shown to 
the right of the icons, selecting allows you to 
change the identified test vehicle.

View Record
Selecting the icon opens an editable 
worksheet of vehicle records.
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User Manual

This option opens this document, which provides overall navigation and operation information for 
the diagnostic tool.

Version Info

This option opens a window showing the version of the software and a copy of the Software 
License Agreement. Select OK to close the window.

Activation Status

This option opens a dialog box with version and licensing details for the system, and activation 
status for the diagnostic tool and all other modules.

3.3.5  Windows Toolbar

This is the standard Windows toolbar. Your diagnostic tool is a fully functional personal computer 
based on the Windows Embedded Standard operating system. Refer to Microsoft documentation 
for additional information.

Windows System Tray ShopStream Diagnostic Suite Programs

The Windows system tray may contain standard Windows application icons (e.g. Wireless 
Network Connection Status, Audio volume, etc) and specialized application icons designed for 
use only on this diagnostic tool (e.g. ShopStream Update Tool and Virtual Keyboard). Refer to 
Microsoft software documentation for additional information on the standard Windows 
applications. For additional information on the ShopStream Update Tool and Virtual Keyboard, 
see:

ShopStream Update Tool - “ShopStream Update Tool (SST)” on page 165

Virtual Keyboard - “Virtual Keyboard” on page 18
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3.4   Virtual Keyboard
The Virtual Keyboard allows you to type characters and key in information to complete form and 
data entry fields, similar to a physical keyboard. 

The Virtual Keyboard is normally running in the Windows background and can be opened by 
pressing the Virtual Keyboard button on the diagnostic tool. The program can be accessed as 
follows: 

• Virtual Keyboard button on the diagnostic tool control panel - opens the Virtual Keyboard

• Virtual Keyboard icon in the Windows system tray - opens the Virtual Keyboard menu

Menu options include:

- Hide Virtual Keyboard - minimizes the keyboard

- Close Virtual Keyboard - closes the Virtual Keyboard program

- Show Virtual Keyboard - displays the keyboard

- Settings - opens the Virtual Keyboard settings window (Figure 3-5)

- About - displays the Virtual Keyboard program software version number

• Virtual Keyboard program selection from the Windows “All Programs” or “Startup” 
menus - starts the Virtual Keyboard program and adds the Virtual Keyboard icon to the 
Windows system tray

NOTE:
i As an alternative, you can connect a USB keyboard to the diagnostic tool and use it to key in 

information. 

Figure 3-3 Virtual Keyboard button and system tray icon
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1— Settings icon - opens the Virtual Keyboard settings window (Figure 3-5)

2. Expand icon - expands the Virtual Keyboard to full display (press again to return to 
standard display)

3. Top - moves the keyboard to top of screen

4— Close - closes the keyboard

5— Bottom - moves the keyboard to bottom of screen
Figure 3-4 Virtual Keyboard (shown expanded) 

NOTE:
i The Virtual Keyboard can be set to open automatically, when a data field or form is selected in 

certain applications. See the Settings window (Figure 3-5) for selection options.

Figure 3-5 Virtual Keyboard settings window 

3.5   Wi-Fi Setup
Certain applications in the ShopStream Diagnostic Suite require wireless Internet connection. The 
wireless network connection status icon is typically available from the Windows system tray and 
can be used to access the wireless network connection setup. Refer to Windows user 
documentation for wireless network setup instructions. 
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Chapter 4 Scanner Operations

There are two versions of the VERUS Diagnostic Tool; operation and function are similar for both. 
The information in this chapter applies to both, unless otherwise specified.

Standard Version

On early-model VERUS Diagnostic Tools the Scanner is built (integrated) into the Diagnostic 
Tool. During scanner testing, the data cable is connected directly from the Diagnostic Tool to 
the data link connector on the vehicle.

Wireless Version

On later-model VERUS Diagnostic Tools the Scanner (referred to as a Scan Module) is a 
separate unit that communicates wirelessly with the Diagnostic Tool. During scanner testing, 
the data cable is connected directly from the Scan Module to the data link connector on the 
vehicle.

The Scanner function allows you to establish a data link to the electronic control systems of the 
vehicle being serviced to retrieve diagnostic trouble codes (DTCs), view live data parameters, and 
perform tests. The Scanner function can access the electronic control module (ECM) for various 
vehicle control systems such as engine, transmission, antilock brake system (ABS) and more.

Scanner and OBD-II testing requires connecting the Diagnostic Tool to the test vehicle using the 
data cable and test adapters and/or Scan Module (depending on version). Onscreen data cable 
connection instructions are provided. Additional connection information can be found in the 
appropriate vehicle communication software manual for the test vehicle, which is available 
through the Help menu.

4.1   Demonstration Program
The Scanner demonstration program allows you to become familiar with many of the test 
capabilities without connecting to a vehicle. Sample data and mock test results help you learn the 
menus and basic operations of the Scanner function.

IMPORTANT:
Do not connect a vehicle to the Scan Module while in the Demonstration mode.

z To start the demonstration program:

1. From the Home screen, select the Scanner icon to open the manufacturer menu.

The manufacturer menu includes all makes for which Scanner information is available. There 
is also a Demonstration icon included in the list.
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Figure 4-1 Sample demonstration selection

2. Select the Demonstration icon.

A menu of demonstration choices may display one of the following:

– 2009 Peugeot 407—contains simulated data for a 407 Diesel 

– OBD Training Mode—provides simulated data for an OBD-II/EOBD vehicle that allows 
you to access any of the standard functions.

3. Select either option and a confirmation message displays.

4. Select OK to load the selected database.

5. Follow the on-screen instructions and select as needed until the Systems menu displays.

6. Select from any of the systems listed, then select from the submenus.

4.2   Basic Operation and Navigation
This section describes the basic menus, controls and navigation of the Scanner function and 
select scanner tests.

4.2.1  Screen Messages

Screen messages appear when additional input is needed before proceeding. There are three 
types of on-screen messages; confirmations, warnings, and errors.

• Confirmation Messages - Confirmation messages inform you when you are about to perform 
an action that cannot be reversed or when an action has been initiated and your confirmation 
is needed to continue. When a user-response is not required to continue, the message 
displays briefly before automatically disappearing.

• Warning Messages - Warning messages inform you when completing the selected action 
may result in an irreversible change or loss of data.

• Error Messages - Error messages inform you when a system or procedural error has 
occurred. Examples of possible errors include a disconnected cable or a peripheral, such as 
a printer, is powered off.
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4.2.2  Making Selections

The Scanner software is a menu driven program that presents a series of choices one at a time. 
As you select from a menu, the next menu in the series displays. Each selection narrows the focus 
and leads to the desired test. Use your fingertip or the stylus to make menu selections.

4.2.3  Scanner Screen Layout
The Scanner screens typically include three sections (Figure 4-2):

1— Scanner Toolbar

2— Main Body

3— Lower Toolbar
Figure 4-2 Scanner screen layout
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Scanner Toolbar

The Scanner toolbar contains a number of icons that allow you to configure the displayed data and 
to exit. The table below provides a brief explanation of the Scanner toolbar icon operations:

The Scanner toolbar is used to configure certain aspects of the displayed data and to exit. The 
following sections explain how to use the toolbar.

Table 4-1 Scanner toolbar icons

Name Icon Description

Exit
Closes the current test and returns you 
to the menu.

Back
When available, returns to the 
previously viewed screen.

Custom
Allows you to select which parameters 
are displayed on the screen.

Alarms
Allows you to set an alarm on certain 
data parameters when the signal goes 
above or below the alarm setting.

Properties
Allows you to adjust the display 
characteristics for all of the data 
screens.

Graph View
Allows you to simultaneously view up 
to 16 data graphs at a time.

Save
Saves a copy of the current frame of 
data that can be viewed on the tool or 
in ShopStream Connect.

Print
Opens a standard Windows Print 
dialog box for saving a print copy of the 
current frame of data.

More
Opens a dropdown menu of the 
additional options shown below.

Scale
Switches the scale values, displayed 
along the left-hand side of the graphs, 
on and off.

Sweep
Switches the sweep values, displayed 
at the base of the graphs, on and off.
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Custom

The Custom icon on the Scanner Toolbar is used to determine which specific parameters display. 
Minimizing the number of parameters on the data list allows you to focus on any suspicious or 
symptom-specific data parameters. You can add or remove most parameters from the list. Any 
parameter that has a lock icon next to it cannot be removed from the list.

IMPORTANT:
Limiting the number of parameters that display allows for a faster refresh rate of the data. A 
smaller data lists also reduces the amount of memory used for saved files.

z To create a custom data list:

1. Select Custom on the Scanner Toolbar.

The parameter selection dialog box with all of the parameters selected opens (Figure 4-3).

2. Select the Deselect All icon to clear the highlights from the screen.

3. Create a custom data list by selecting the parameters to be included. Highlighting indicates a 
parameter that displays, parameters that are not highlighted do not display.

Figure 4-3 Sample custom configuration screen

Keep the following in mind when configuring a custom data list:

– Gesture scroll if the list of parameters is longer than what is shown on the screen.

– Use the Select All icon to display the complete list.

– Use the Deselect All icon to remove all the currently selected parameters from the list.

– Select individual parameters to highlight and include them in the list.

– Select individual highlighted parameters to remove them from the list.

– Use the Cancel icon to return to the data display.

4. Once all desired parameters have been selected, return to the data list:

– Use the List View icon to return to a data screen in PID List format.

– Use the Graph View icon to return to a data screen in Graph View format (see Graph 
View on page 27 for details.
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NOTE:
i Graph View is only available when 16 or fewer parameters (the number that can display on a 

single screen) were selected for the custom list. Make sure that no more than 16 parameters are 
highlighted if the screen displays a single graph when the Graph View icon is selected.

Alarms

Alarms are visual indicators alongside a parameter in the data display list that change color to 
show the signal status. A green alarm indicates on, a gray alarm indicates off. Only digital 
parameters, those with a range limited to two states, can have alarms. Parameters with 
continuous ranges, such as variable voltage and pressure values, cannot have alarms. The alarm 
indicator assignments remain as selected until you exit the data list:

z To configure alarm settings:

1. Select the Alarms icon on the Scanner Toolbar.

The Alarm List dialog box opens.

2. Check the parameters that you want to show alarms.

3. Select Save.

Alarm indicators now appear next to the selected parameters in the Data List (Figure 4-4).

Figure 4-4 Sample alarm indicators

NOTE:
i Alarms can only be set for certain parameters. If the Alarm List dialog box is empty, no parameters 

are available and alarms cannot be set.
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Properties

The Properties icon on the Scanner Toolbar is used to configure certain characteristics of the 
parameter graph display. Selecting opens a Properties dialog box that allows you to adjust colors, 
settings, and sweep (Figure 4-5).

Figure 4-5 Sample properties dialog box

Selecting either color option, Edit Plot Color or Edit Background Color, opens a standard color 
selection dialog box. Select a color, then select OK to close the dialog box.

The Show Grid icon is used to switch a background grid pattern on the data graphs on and off:

• To switch the grid on; select to highlight Show Grid, then select Accept.

• To switch the grid off; select Show Grid twice so it is not highlighted, then select Accept.

The Samples After Trigger setting determines how many data samples are recorded following a 
triggering event. The highlighted samples icon indicates the number of frames that are included in 
the recording after a triggering event.

The sweep options let you choose the amount of data that displays across the graph. Values are 
in sample points, or frames of data. A frame of data equals one complete transmission of the serial 
data by the electronic control module.
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Graph View

Graph View allows you to simultaneously display up to 16 parameter graphs (Figure 4-6). The 
graphs must first be opened in the data list in order to be included when Graph View is selected 
from the toolbar. The display defaults to a single graph if more than 16 graphs are open when the 
toolbar icon is selected. Should this happen, return to the data list and close some of the graphs.

A toolbar in Graph View allows you switch scale and sweep values on and off, and to return to the 
List View. The Data Buffer toolbar at the base of the screen remains active.

NOTE:
i The screen does not scroll in Graph View mode, it adjusts to show only the selected parameters.

Figure 4-6 Sample Graph View screen

Graph View mode can also be engaged from the custom data list configuration screen. Refer to 
Custom on page 24 for details.

z To use Graph View:

1. Open the graph for each data parameter, up to sixteen, that you wish to view.

2. Configure parameter settings, such as Triggers, Auto Scale, and Sweep, as needed. 
Remember, these must be selected before entering Graph View.

3. Select Graph View on the Scanner toolbar.

All of the open data graphs now appear on a single screen (Figure 4-6).

4. Select List View on the Scanner toolbar to return to a normal view.



28

Scanner Operations Basic Operation and Navigation

Save

The Save icon is used to record movies of vehicle datastream values. Saved files and be helpful 
when trying to isolate an intermittent problem or to verify a repair during a road test.

z To save a movie:

• Select Save.

A save movie dialog box displays while data is being saved. The movie is saved when the 
message box disappears.

Figure 4-7 Sample save dialog box

Saved files can later be viewed by selecting Data Manager on the home screen. From the Data 
Manger open the Scanner Data Folder, then locate and select the saved file to be viewed.

Print

Selecting Print from the toolbar opens a standard Windows Print dialog box. Select from the 
options as needed to print the current frame of data.

Figure 4-8 Sample print dialog box
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If the Diagnostic Tool is connected to a printer, the current frame of data is printed. If the Diagnostic 
Tool is not connected to a printer, the frame of data is saved as an “XPS” file. A dialog box opens 
so that you can name the print file and specify the location that it is saved to, follow the on-screen 
instructions.

Saved files can be printed at a later date, or opened and reviewed.

NOTE:
i Saved print files cannot be viewed using the Data Manager, they can only be opened into an 

internet browser.

z To open a saved print file:

1. Minimize the Diagnostic Suite to view the desktop.

2. From the desktop select My Documents > ShopStream > Scanner Data Folder.

3. Locate the file you wish to view.

4. Double tap the file to open it.

The internet browser and file open.

More

Whenever the More icon appears on the toolbar it indicates that there are additional options 
available. Selecting the More icon from the Scanner toolbar opens a dropdown menu that offers 
two choices that only apply to data graphs:

• Scale

• Sweep

Scale

The Scale option switches the scale values, displayed along the left-hand side of the data graphs, 
on and off (Figure 4-9). The dropdown menu closes once a selection is made.

Figure 4-9 Sample data graph scales
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Sweep

The Sweep option switches the sweep values, displayed below the data graphs, on and off 
(Figure 4-10). The dropdown menu closes once a selection is made.

Figure 4-10 Sample data graph sweep

Main Body

The main body of the screen varies depending on the stage of operation. The main body can show 
vehicle identification selections, the main menu, test data, instructions, troubleshooting 
information, controls, and other diagnostic information.

Lower Toolbar

Whenever communication is established with a vehicle, the Scanner continuously records data 
transmitted by the ECM in the data buffer. The toolbar below the main body of the screen contains 
the icons for navigating the buffered data (Table 4-2).

Table 4-2 Data buffer toolbar icons (sheet 1 of 2)

Name Icon Description

Snapshot Arms the software to take a snapshot of vehicle data

Go To Start Moves to the first frame in the data buffer

Pause
Suspends data capture and changes to show the 
Play icon

Play
Starts or resumes data capture and changes to show 
the Pause icon
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Use the slider in the middle of the toolbar to quickly move through paused data.

Figure 4-11 Sample data buffer slider

Go To End Moves to the last frame in the data buffer

Clear Erases data in the data buffer

Step Back Moves to the previous frame in the data buffer

Frame Counter Indicates the data buffer frame currently displayed

Step Forward Moves to the next frame in the data buffer

Zoom In
Increases the magnification by decreasing the sweep 
of the graph

Zoom Out
Decreases the magnification by increasing the 
sweep of the graph

Table 4-2 Data buffer toolbar icons (sheet 2 of 2)

Name Icon Description
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4.2.4  Menu Options

The Toolbar Menu icon at the base of the screen opens a menu near the top of the display.

Figure 4-12 Sample Scanner Menu icon options

The following Menu options are available:

• Safety Information—opens the Important Safety Instructions explained previously.

• File—allows you to print or save the data being viewed.

• Tools—allows you to perform certain maintenance operations and adjust tool settings.

• Help—allows you to view supporting documentation.

File

Use to print or save a copy of the data currently being viewed. Menu options include:

• Save—opens a submenu with these options:

– Screenshot—saves a graphic image of the current screen.

– Collected Data—saves a recording of all the data currently in the buffer plus the number 
of frames designated after the trigger event (see Properties on page 26).

• Print—opens a submenu with these options:

– Screen—sends the current screen image to a printer.

– Troubleshooter—prints the full text of the troubleshooter topic shown in the main body.

Selecting an option opens a Windows Print dialog box for printing or saving the file.

Tools

This option allows you to adjust tool settings to your personal preferences. Selecting Tools opens 
a menu with two options:

• Units Setup

• Display BEN
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Units Setup

The units of measurement can be changed for temperature, vehicle speed, air pressure and other 
pressure readings. Choose between US customary or metric units of measure.

NOTE:
i All measurement units return to their default values when different software is selected.

z To change the units setup:

1. Select Tools > Units Setup.

The Measurement Units Setup dialog box opens.

Figure 4-13 Sample Units Setup screen

2. Use the dropdown menus to select the desired value for each item.

3. Select Accept to close the dialog box and apply the changes.

Display BEN

Selecting opens a screen with the Balco Engine Number (BEN) of the currently identified vehicle. 
The BEN is used internally for data coordination, and you may be asked to provide to a Customer 
Care representative for troubleshooting communication problems.

Help

A variety of utilities and additional resources are available through the Help menu:

• User’s Manuals

• About Scanner Hardware Version

• Activation Status

The User Manual, Version Info, and Activation Status options are the same as explained 
previously, see Menu Options on page 32 for details. Other options are explained below.
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User’s Manuals

This option opens a menu of additional support documentation, such as vehicle communication 
software manuals, available to assist in your diagnosis. These manuals provide connection 
information, detailed test procedures, and other resource material for specific vehicles.

Figure 4-14 Sample User’s Manuals menu

Select Exit to close the Help module and return to the Scanner.

About Scanner Hardware Version

This option opens a dialog box showing the hardware version and other details about the Scanner 
module. A Copy to Clipboard icon allows you to paste the information to a document or e-mail.

About Scanner

This option opens a dialog box that shows the software version and other Scanner module details. 
A Copy to Clipboard icon allows you to paste the information to a document or e-mail.

4.3   Scanner Operation
Before initial use the Scan Module must be paired with the Diagnostic Tool to establish a wireless 
communication link. Refer to Pairing The Scan Module on page 55 for details. Both the Scan 
Module and the Diagnostic Tool must be powered on.

The Scanner function has two main operation features:

• Scanner—allows communication with the vehicle ECMs to review DTCs, view parameter 
data, and perform functional tests.

• Fast-Track Troubleshooter—provides access to troubleshooting information from a database 
of experienced based information developed by master technicians.

z Basic Scanner Operation Steps

1. Open Scanner—Select Scanner on the Home screen.

2. Identify the vehicle—Identify the test vehicle by selecting from the menu options.

3. Connect the data cable to the vehicle—Follow the on-screen connection instructions to 
connect to the test vehicle.

4. Select a system—Select the system to be tested from the systems menu.

5. Select a test —Select the desired test.



35

Scanner Operations Scanner Operation

4.3.1  Vehicle Identification

The Scanner information presented is provided by a direct link to the ECM of the test vehicle. 
Therefore, certain attributes of the test vehicle must be entered into the Diagnostic Tool so that the 
data displays correctly. Vehicle identification information is carried over if you enter the Scanner 
function either from the Guided Component Test module or from one of the records stored in the 
Vehicle History module. However, in some instances you may need to enter additional attributes.

The vehicle identification sequence is menu driven, simply follow the screen prompts and make a 
series of choices. Each selection advances to the next screen. A Back icon in the upper left corner 
of the screen returns to the previous screen. Procedures vary by vehicle.

z To identify a vehicle for Scanner testing:

1. Select the Scanner Function icon from the Home screen.

A list of manufacturers displays (Figure 4-15).

Figure 4-15 Sample manufacturer list

2. Select the manufacturer of the test vehicle from the list.

A model year menu displays.

3. Select the year of the test vehicle from the menu.

A list of vehicle types or models displays. Several selections may be required to identify the 
vehicle type and model, follow the screen prompts and enter the required information.

A confirmation page showing the identified vehicle displays once all the required data has 
been entered. Review the information to make sure it is correct.
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4. Select OK and a list of systems available for testing on the vehicle displays (Figure 4-16).

Figure 4-16 Sample available tests list

5. Select a test to continue.

The identification sequence is now complete.

Alternative Vehicle Identification

Occasionally, you may identify a test vehicle that the Scanner does not recognize, the database 
does not support, or has some unique characteristics that prevent it from communicating with the 
Scanner through the normal channels. In these instances, there is an alternate choice that allows 
you to establish communication with the vehicle by other means. In addition to being able to 
identify a different manufacturer, the following alternative is available:

• OBDII/EOBD—allows you to perform generic OBD-II or EOBD tests, see OBD Direct 
Operations on page 67 for additional information.

4.3.2  Connecting to a Vehicle

Data Cable Connection (standard version)

Connection of the data cable to the Diagnostic Tool and vehicle DLC is required for Scanner and 
OBD-II/EOBD testing.

Depending on the vehicle, the supplied DA-4 data cable may be used alone or may require 
optional adapters. 

• All OBD-II/EOBD compliant vehicles - Use the supplied DA-4 data cable. The 26-pin end of 
the cable attaches to the data cable connector on the top of the Diagnostic Tool. The16-pin 
end connects to the vehicle DLC. The cable connectors are secured with captive screws.

• All non-OBD-II/EOBD (OBD-I) compliant vehicles - Use the supplied DA-4 data cable with 
the optional DA-5 adapter and a manufacturer specific adapter. The 26-pin end of the cable 
attaches to the data cable connector on the top of the Diagnostic Tool. The16-pin end 
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connects to the DA-5 adapter, the DA-5 adapter connects to the manufacturer specific adapter 
and then connects to the vehicle DLC. The cable connectors are secured with captive screws.

On-screen cable and adapter connection instructions are provided while using the Scanner and 
OBD-II/EOBD functions. The instructions may also include the location of the vehicle DLC 
(Figure 4-17). If required, additional connection information can be found in the appropriate 
vehicle communication software manual for the vehicle. Vehicle communication software manuals 
are available online, see the website information at the front of this manual

Figure 4-17 Vehicle connection data cable message

For data cable vehicle power connection information, see Power Sources on page 8.

z To connect the data cable to the vehicle:

1. Follow the on-screen instructions for connecting to the vehicle (Figure 4-17).

2. Select Continue once the data cable is connected.

The Diagnostic Tool establishes communication then displays a list of available tests. If the 
Diagnostic Tool is unable to establish a communications link, a “no communications” message 
displays.

3. Select from the available tests to open a submenu of test options.

No Communication Message

When the screen displays a “no communication” message, it means the Diagnostic Tool and the 
vehicles electronic control module cannot communicate with each other for some reason.

The following conditions cause a “no communication” message to display:

• The Scan Module is unable to establish a communication link with the vehicle.

• You selected a system for testing that the vehicle is not equipped with (such as ABS).

• There is a loose connection.

• There is a blown vehicle fuse.

• There is a wiring fault on the vehicle, or in the data cable or adapter.

• There is a circuit fault in the data cable, Personality Key, or adapter.

• Incorrect vehicle identification was entered.

Refer to the Vehicle Communication Software manuals for manufacturer-specific problems.
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Scan Module Connection (wireless version)

The Scan Module is a wireless device that is connected (using the vehicle data cable) to the 
vehicle and transmits vehicle data to the Diagnostic Tool. To use the Scanner function the Scan 
Module must be paired with the Diagnostic Tool. If the Scanner tries to communicate with the 
vehicle and the Scan Module is not connected to the vehicle, a Connect Data Cable confirmation 
screen will display. For Scan Module connection and operation information, see Pairing The Scan 
Module on page 55. 

4.3.3  Vehicle System Selection

z Selecting a vehicle system:

1. After the vehicle has been identified, a list of available systems for testing displays 
(Figure 4-18). Select a system to continue.

Figure 4-18 Systems menu
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Code Scan Option (Systems Menu-Wireless Only)

NOTE:
i Depending on the vehicle, the Code Scan option may be available from the systems menu 

(Figure 4-19). 

Figure 4-19 Systems Menu - Code Scan

Code Scan is used to scan all available vehicle control modules for DTC’s at once. This time 
saving feature displays the following information progressively as the modules are scanned.

• The total number of systems detected

• A summarized list of modules detected with DTCs totals for each

Individual system module reports that include a list of the DTCs set, the DTC common replaced 
parts graph and a direct link to SureTrack®  Fix It! information for each specific DTC. For additional 
information on SureTrack, the Fix It! and common replaced parts graph features, see Using 
SureTrack on page 161.

NOTE:
i SureTrack information is optional, and is displayed when SureTrack is activated and if data is 

available for a selected DTC.
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Figure 4-20 Code Scan Features

1— SureTrack Common Replaced Parts Graph

2— Code Scan Summary

3— Progressive status indicator 

4— Systems Summary List (with DTC totals)

5— Individual System DTC Reports

6— SureTrack Fix It! icon
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Select Print from the toolbar to print the Code Summary Report.

Figure 4-21 Printed Code Summary Report
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4.3.4  Vehicle Test Selection

z Selecting a vehicle test:

1. After a system is selected and the Scanner establishes communication with the vehicle, the 
Scanner Main menu displays available tests. Select a menu item to continue.

Figure 4-22 Scanner Main menu

Main menu options vary slightly by year, make, and model. The main menu may include:

• Data Display— displays data parameter information from the vehicle electronic control 
module. Selecting may open a submenu of viewing options.

• Codes Menu—displays diagnostic trouble code (DTC) records from the vehicle electronic 
control module. Selecting may open a submenu of viewing options.

• Clear Codes—erases DTC records and other data from the ECM. This selection is found on 
a Codes submenu for some models.

• Functional Tests—provides specific subsystem and Guided Component Tests. The tests 
vary depending on the manufacturer and model.

• Actuator Tests—similar to functional tests, checks the operation of certain actuators, such as 
solenoid valves and relays.

• Memory Resets—allows you to reprogram adaptive values for certain components after 
making repairs. Selecting opens a submenu. These options are found on the Functional Tests 
Menu for some models.

• System Tests—provides specific subsystem testing. Performing these tests is similar to 
functional tests.

• Generic Functions—lets you access certain available Generic OBD II functions from a 
proprietary menu (1996 and newer vehicles only).

• Troubleshooter—provides step-by-step procedures, integrating parameter data and 
retrieving trouble codes when appropriate, for specific symptoms of the identified vehicle.
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Data Display

Depending upon the test vehicle, this selection may appear as Data, Data Display, Data Only, 
Data (No Codes), or something similar. All are similar. Selecting has one of the following results:

• A submenu of data viewing choices displays.

• Vehicle data displays.

A submenu displays when more than one data viewing mode is available on the identified vehicle. 
On some models, the engine must be started or cranked before data can be displayed. For these 
models, a “Waiting to Communicate” message displays if the engine was not cranked or started.

Data Screens

When a Data selection is made, the screen displays the data list for the selected module.The 
items available for any electronic control module vary from one vehicle to another.

Data is presented in a 2-column format. An abbreviated parameter name is at the left of each 
column and its value is at the right edge of the column. Parameters display in the order that they 
are transmitted by the ECM, so expect variation between vehicles.

Gesture scrolling allows you to quickly move through the data list. Simply touch the screen and 
drag your finger up or down to reposition the parameters being displayed. Position bars 
momentarily appear to the right of each column to indicate the position of the current screen in 
relation to the entire list as you scroll. Each column of parameters scrolls independently of the 
other column. Figure 4-23 shows a typical data screen.

1— Graph icon

2— Parameter name

3— Parameter value
Figure 4-23 Sample data screen
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Data Graphs

Select the Graph icon to open a data graph for that parameter (Figure 4-24). Selecting a 
parameter for graph view moves it to the top of the list. Select the Graph icon again to close the 
graph for that parameter and return to a data list view.

Figure 4-24 Sample graph view

The icons that display on each data graph allow you configure settings for the selected graph only:

Triggers

Triggers establish threshold values, an upper limit and a lower limit, for recording a data snapshot. 
A snapshot allows you to closely evaluate conditions that caused the triggering event.

When a snapshot is taken, the Scanner captures additional data after the trigger point is detected, 
data collection pauses, and the buffered information is automatically saved as a movie. This gives 
you a complete picture of what was happening before the fact, what occurred at the trigger point, 
and what happened after the fact.

Data collection is paused following a trigger event. Select the Play icon to resume viewing live 
data. A vertical line now appears on each of the data graphs to indicate the triggering point. The 
trigger line on the parameter that triggered the snapshot is a different color than those on the other 
graphs. This makes it easy to determine which parameter caused the trigger when triggers are set 
for multiple parameters.

Table 4-3 Data graph icon operations

Name Icon Description

Expand/Collapse
Select to expand the graph to fill the entire screen, 
select again to collapse the graph to the standard 
view.

Graph Properties
Select to open the Graph Properties dialog box, 
which allows you to set triggers for recording a 
snapshot and to adjust the scale.
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z To adjust the amount of data collected after a trigger:

1. Select the Properties icon on the Scanner toolbar to open the dialog box.

2. Highlight one of the Samples After Trigger options:

3. Select the Accept icon to close the dialog box.

NOTE:
i You can also adjust the amount of data collected after a triggering event using the Properties icon 

on the Scanner toolbar. See Properties on page 26 for additional information.

z To set triggers and record a snapshot:

1. Select the Graph Properties icon on the parameter graph you wish to set triggers on.

The Graph Properties dialog box opens.

2. From the Graph Properties dialog box, select Triggers On.

A check mark appears in the box and the Min and Max fields activate (Figure 4-25).

3. Select either Max: (maximum) or Min: (minimum) to activate that field and open the keyboard.

4. Type the desired trigger value into the field.

5. Select the other field and enter a trigger value, then close the virtual keyboard.

6. Select Save to close the dialog box.

Trigger lines (blue for upper and red for lower) display on the selected parameter graph.

The area between the upper and lower trigger lines establishes the triggering condition. Any 
data points that register outside of the set trigger conditions initiates a snapshot.

Figure 4-25 Sample Graph Properties dialog box

7. Select Snapshot on the Data Buffer Toolbar to arm the snapshot.

The Snapshot icon changes color to indicate it has been armed (Figure 4-26).

Figure 4-26 Sample armed Snapshot icon
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Once all of the data is compiled, data collection pauses and the information is saved as a 
movie. A confirmation screen displays to let you know the name automatically assigned to the 
saved file and where to locate it.

Figure 4-27 Sample saved movie confirmation screen

8. Select OK to close the confirmation screen.

9. Select the Play icon on the toolbar to resume viewing live data.

NOTE:
i Selecting an armed Snapshot icon disarms it.

Scale

Scale adjusts the upper and lower values displayed on the vertical axis of a data graph. Two scale 
modes are available; auto scale and manual scale. Auto scale, which is the default setting, 
automatically adjusts the graph scale based upon the minimum and maximum values transmitted 
by the ECM. Manual scale allows you to set the minimum and maximum values.

z To manually set the scale on a graph:

1. Select the Graph Properties icon to open the dialog box for the graph you wish to scale.

2. From the Graph Properties dialog box (Figure 4-28), select Auto Scale On.

The check mark is cleared from the box and the minimum and maximum fields activate.

3. Select either Max: (maximum) or Min: (minimum) to activate that field and open the keyboard.

4. Type the desired scale value into the field.

5. Select the other field and enter a value, then close the virtual keyboard.

6. Select Save to close the dialog box.
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Figure 4-28 Sample manual scale selection

The dialog box closes and the parameter scale is now at the set values.

Using Zoom

The zoom options on the Data Buffer toolbar allow you to change the magnification level of the 
sweep when viewing data graphs. Use the Zoom In (+) icon to increase magnification, and the 
Zoom Out (–) icon to decrease magnification.

Codes Menu

This selection may appear as Codes, Codes Menu, Codes Only, Codes (No Data), or something 
similar on the menu. Selecting opens a list of data parameter viewing options that may include:

Display Codes

Selecting opens either a list of diagnostic trouble codes (DTCs) stored in the selected electronic 
control module (ECM), or a submenu of DTC viewing options. Submenu options may include:

• Trouble Code Information—opens a list of codes in ECM memory.

• History Codes—opens a list of codes whose symptoms are not currently present. History 
codes indicate an intermittently occurring problem.

• Failed This Ignition—opens a list of codes that set during the current ignition cycle.

• MIL SVS or Message Requested—displays ECM requests to light the malfunction indicator 
lamp (MIL) or service vehicle soon (SVS) lamp, or display a driver information alert.

• Last Test Failed—displays a complete list of failed tests.

• Test Failed Since Code Cleared—displays a list of tests that failed since the last time codes 
were cleared from ECM memory.

If SureTrack® (optional) is active and data is available for a selected DTC, additional 
troubleshooting information from SureTrack (e.g. Common Replaced Parts data (), Real Fix and 
Related Fixes) will also be available. For additional information about using SureTrack, see 
SureTrack® on page 160.
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A code list includes the DTC and a brief description, and a SureTrack Fix It! icon that opens a 
submenu allowing you additional information about the DTC (Figure 4-29).

Figure 4-29 Sample code list

Clear Codes

The Scanner clears trouble codes from the electronic control module memory on some vehicles. 
If this function is not available on the test vehicle, Clear Codes does not appear as a menu option.

z To clear codes:

1. Select Clear Codes from the Codes Menu.

 A confirmation message displays.

2. Make sure any conditions shown on the confirmation message are met, then select Yes.

A “codes cleared” message displays once the operation is complete.

3. Select Continue to return to the Codes Menu.

Freeze Frame/Failure Records

This selection displays the DTC that was set, along with corresponding data, when the ECM 
commanded the malfunction indicator lamp (MIL) to turn on.
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DTC Status

This selection allows you to view the records of a particular DTC.

z To check DTC status

1. Select DTC Status from the Codes Menu.

The DTC Status entry field displays and the virtual keyboard opens (Figure 4-30).

2. Use the virtual keyboard to enter the characters of the DTC.

3. Select the virtual keyboard Backspace icon if needed to erase a character.

4. Select the virtual keyboard Return key once all the code characters are entered.

Figure 4-30 Sample DTC Status entry field

The DTC status report displays (Figure 4-31).

Figure 4-31 Sample DTC status report

5. Select Exit to return to the DTC status entry screen.

6. Select Exit again to return to the Codes menu.
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Functional Tests

The Functional Tests selection is used to access vehicle-specific subsystem and guided 

component tests. Available tests vary by manufacturer, year, and model, and only the available 
tests display in the menu.

There are four general types of functional test operations:

• Information Tests—are read-only tests, like selecting “VIN” from a Functional Tests menu to 
display the VIN of the identified vehicle.

• Toggle Tests—switch a component, such as a solenoid, relay, or switch, between two 
operating states.

• Variable Control Tests—command a certain value for a system or component, such as 
varying the spark timing in 1° increments or the EGR valve duty cycle in 10% increments.

• Reset Tests—reset the adaptive, or learned, values that are stored in the electronic control 
module.

Selecting Functional Tests opens a menu of test options that varies by make and model. 
Selecting a menu option either activates the test or opens a submenu of additional choices. Follow 
all screen instructions while performing tests. How and what information is presented on the 
screen varies according to the type of test being performed.

IMPORTANT:
Do not enter any functional tests while driving on a road test. During some functional tests, the 
ECM makes changes to ignition timing, fuel delivery, and other engine functions, which may affect 
engine operation and vehicle control.

Some toggle and variable control tests display functional test controls at the top of the screen with 
data stream information below (Figure 4-32).

Figure 4-32 Sample functional test controls
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Functional test controls allow you manipulate the test signal as shown in Table 4-4.

Generic Functions

The Generic Functions selection opens a menu of available OBD-II/EOBD functions on 1996 
and newer vehicles. For additional information on generic functions refer to the Global OBD 
Vehicle Communications Software Manual. Menu options typically include:

• Readiness Monitors—displays the status of the OBD-II/EOBD required monitors

• ($02) Freeze Frame—displays data stored in ECM memory when a DTC is set

• ($05) Oxygen Sensor Monitoring—displays on-board oxygen sensor monitoring test results

• ($06) On-Board Monitored Systems—displays the status of system monitors

• ($08) Request Control of On-Board System—establishes bidirectional ECM communication

• ($09) Calibration Identification—displays the ECM calibration identification numbers

• ($09) Calibration Verification Number—displays the ECM calibration

• ($09) In-Use Performance Tracking—displays a monitoring conditions report

• ($09) Vehicle Identification Number—displays the VIN

• ($0A) Emissions Related Fault with Permanent Status—displays a record of permanent codes

Troubleshooter

Fast-Track® Troubleshooter is a database of experience-based information of validated 
real-world repair strategies that have been compiled by top-notch technicians. Troubleshooter 
simplifies the diagnosis process, as it contains information on virtually all common diagnostic 
trouble code (DTC) problems and driveability symptoms.

Table 4-4 Functional test control icons

Name Icon Description

Test Activates the test.

Return Moves focus back to the data list.

Change List Allows you to switch data lists.

Custom
Allows you to select which parameters display during 
the functional test.

Minus
Switches an item to low or off, or incrementally 
reduces a variable signal.

Plus
Switches an item to high or on, or incrementally 
increases a variable signal.
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Troubleshooter information is organized into a series of diagnostic tips that are designed to quickly 
lead you to the root cause of a particular problem. The tips are vehicle-specific, which means only 
tips that relate to the identified vehicle are presented. Selecting opens a menu that may include:

• Code Tips—provides detailed information on setting conditions, testing, and interpreting test 
results for specific codes.

• Symptom Tips—provides diagnostic tests and procedures based on vehicle operation.

• Time Savers—provides supplemental information, such as firing order and #1 cylinder 
location, that may be needed to make a diagnosis.

• Common Problems—provides advice and remedies for certain “pattern failures” that have 
been experienced on vehicles of the same model.

• Tests and Procedures—explains how to perform certain tests on the specific test vehicle. 
Some tips provide specifications and installation information as well.

• Fast-Track Data Scan (Normal Values)—contains information and guidelines on how to 
validate data readings for certain sensors and actuators, live data values are provided.

NOTE:
i Troubleshooter appears in a Scanner menu only if tips are available for the system selected on the 

identified vehicle.

Certain live data parameter values display directly within the tip when performing Troubleshooter 
tests and procedures. A tip may also contain a hyperlink to a Troubleshooter Reference, another 
test or procedure, or a supplemental operation, such as Clear Codes. Hyperlinks are shown in 
blue, and selecting them opens the link. Troubleshooter References open in a separate window. 
(Figure 4-33).

1— Live data values

2— Hyperlink
Figure 4-33 Sample data values within a Troubleshooter tip
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4.4   Stopping Communication and Exiting the Scanner
The Scanner remains open as long as there is an active communication link with the vehicle. You 
must first stop communication with the vehicle in order to exit from the Scanner function. A 
warning message displays if you attempt to exit from the Scanner while it is communicating with 
the vehicle ECM.

NOTE:
i Damage to the vehicle electronic control module (ECM) may occur if communication is disrupted. 

Make sure the data cable and the USB cable are properly connected at all times during testing. 
Exit all tests before disconnecting the test cable or turning off the tool.

z To exit Scanner and disconnect from a vehicle:

When disconnecting the Diagnostic Tool from the vehicle, make sure the Scanner software is 
not communicating with the vehicle.

1. From a codes or data display screen, select the Exit icon on the upper toolbar.

Figure 4-34 Exit icon

The screen goes to the codes or data menu.

2. Select the Back icon on the upper toolbar.

Figure 4-35 Back icon

The screen goes to the system menu.

3. Select the Back icon on the upper toolbar.

A “stopping communication” message briefly displays followed by the systems menu.

4. Select the Change Vehicle icon on the Toolbar.

Figure 4-36 Change Vehicle icon

The vehicle description on the toolbar should now read “No Active Vehicle”.

5. Select the Home icon on the Toolbar.

Figure 4-37 Home icon

The Home screen displays.

6. Disconnect the data cable from the vehicle diagnostic connector.
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This chapter describes the connection, operation, troubleshooting and updating of the Scan 
Module.

5.1   Overview
The Scan Module is a wireless device that is connected to the vehicle and transmits vehicle data 
to the diagnostic tool. 

The Scan Module operates on 12 or 24VDC vehicle power, supplied through the vehicle’s data link 
connector (DLC). 

1— Data cable connector

2— Vehicle power LED (green)

3— Communication issue LED (red)

4— Bluetooth LED (green)

5— Memory card port (remove protective hand grip for access)

6— Universal serial bus (USB) jack (remove protective hand grip for access)
Figure 5-1 Scan Module
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5.2   Pairing The Scan Module
To use the Scan Module with the Scanner or OBD-II/EOBD functions, it must first be paired with 
the diagnostic tool. 

Pairing is the wireless connection (identification) process used to connect the Scan Module to 
your diagnostic tool. 

The Scan Module only needs to be paired once before it’s initial use. The connection configuration 
should remain in memory for all future uses, unless the connection configuration is removed or 
lost. 

NOTE:
i Wireless devices shown in this section are used as reference. Not all devices shown may be 

applicable to your diagnostic tool.

z To pair the Scan Module with the diagnostic tool:

1. Turn on the diagnostic tool.

IMPORTANT:
The Scan Module needs to be powered on during the pairing process. Connect the Scan Module 
to a vehicle or to the diagnostic tool using the USB cable. Make sure the diagnostic tool has a 
charged battery or is connected to the AC/DC power supply.

2. Connect the 26-pin end of the data cable to the Scan Module data cable connector.

3. Connect the 16-pin end of the data cable to a vehicle data link connector (DLC).

The green LED on the Scan Module is illuminated when power is being supplied to the Scan 
Module. For additional information on the Data Cable, see Data Cable Connection on 
page 57.

4. From the diagnostic tool select System Settings > Paired Devices.

5. Select Add from the toolbar, then OK when prompted.

The diagnostic tool searches for compatible wireless devices, then displays the results. 
(Figure 5-2).

Figure 5-2 Sample Scan Module selection
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NOTE:
i Search results include all compatible wireless devices detected, and may include multiple Scan 

Modules if you are in a shop environment where more than one unit is powered on. Available 
module listings include a partial serial number. Make sure the screen listing matches the last six 
digits of the serial number of your Scan Module before continuing. Scan Module serial numbers 
are also printed on the back of the Scan Module (e.g. 123SMC-987654) 

6. Select the Scan Module you wish to connect from the results list.

A search in progress message displays during the pairing procedure (Figure 5-3), the Paired 
Devices screen (Figure 5-4) displays once the procedure completes.

Figure 5-3 Sample pairing in progress message

7. Select the Home icon on the Toolbar.

8. Disconnect the data cable from the vehicle.

The Scan Module and diagnostic tool are now paired for wireless communication and should 
automatically recognize each other when both are powered up.

5.3   Checking Scan Module Paired Status

z To check if the Scan Module is paired to your diagnostic tool:

1. Select System Settings > Paired Devices.

The paired devices screen opens (Figure 5-4).

The Paired Devices screen lists all of the devices paired to the diagnostic tool, and also indicates 
whether or not there is active communication occurring.
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Figure 5-4 Typical Paired Devices screen

2. Verify the Scan Module is in the list of paired devices.

5.4   Data Cable Connection
To use the Scan Module for Scanner and OBD-II/EOBD testing, it must first be connected to the 
vehicle’s data link connector (DLC). 

Depending on the vehicle, the supplied DA-4 data cable may be used alone or may require 
optional adapters. 

• All OBD-II/EOBD compliant vehicles - Use the supplied DA-4 data cable. The 26-pin end of 
the cable attaches to the data cable connector on the Scan Module. The16-pin end connects 
to the vehicle DLC. The cable connectors are secured with captive screws.

• All non-OBD-II/EOBD (OBD-I) compliant vehicles - Use the supplied DA-4 data cable with 
the optional DA-5 adapter and a manufacturer specific adapter. The 26-pin end of the cable 
attaches to the data cable connector on the Scan Module. The16-pin end connects to the DA-
5 adapter, the DA-5 adapter connects to the manufacturer specific adapter and then connects 
to the vehicle DLC. The cable connectors are secured with captive screws.

While using the Scanner and OBD-II/EOBD functions, on-screen cable and adapter connection 
instructions are provided. The instructions may also include the location of the vehicle DLC 
(Figure 5-5). If required, additional connection information can be found in the appropriate vehicle 
communication software manual for the vehicle. Vehicle communication software manuals are 
available online, see the website information at the front of this manual.

Figure 5-5 Vehicle connection data cable message
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For data cable vehicle power connection information, see Vehicle Power on page 9.

z To connect the data cable to the vehicle:

1. While using the Scanner or OBD-II/EOBD function, follow the on-screen instructions for 
connecting the cable and/or any adapters required to the vehicle (Figure 5-5).

2. Select Continue once the data cable is connected to the vehicle.

5.5   Troubleshooting
The Scan Module is a wireless communications device that uses Bluetooth technology to transmit 
vehicle data to the diagnostic tool without a physical connection. The working range of the 
transmitter is about 30 feet (9.14 m). Scan Module operations can be impacted when signal 
interference, or some other condition, disrupts or impairs the wireless communication network. 
These interruptions are usually temporary and easily repaired.

Indicators of wireless communication interference include:

• Slow Scan Module response accompanied by “Error 101” message.

• Slow Scan Module response accompanied by “Error 404” message.

• “Error Occurred” Message when trying to use the Scan Module.

• “Error Occurred” Message after 20 or more minutes sitting idle, particularly if the devices have 
been stationary.

5.5.1  No Communication Message

If the Scan Module is paired to the diagnostic tool and tries to communicate with the vehicle and 
the Scan Module is not connected to the vehicle, a “Connect Data Cable” or “no communication” 
message displays. 

A signal lost due to moving out of range automatically restores itself when the diagnostic tool is 
brought closer to the Scan Module. The Scanner sounds a tone when the signal is lost.

The following conditions cause a “no communication” message to display:

• The Scanner is unable to establish a communication link with the vehicle.

• You selected a system for testing that the vehicle is not equipped with (such as ABS).

• There is a loose connection.

• There is a blown vehicle fuse.

• There is a wiring fault on the vehicle, or in the data cable or adapter.

• There is a circuit fault in the data cable, Personality Key, or adapter.

• Incorrect vehicle identification was entered.

Refer to the Vehicle Communication Software manuals for manufacturer-specific troubleshooting 
information.

5.5.2  Signal Loss / Out of Range Alarm

A signal lost due to moving the diagnostic tool out of range of the Scan Module will automatically 
restore itself when the diagnostic tool is brought closer to the Scan Module. The Scan Module will 
sound an audible tone when the signal is lost.
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5.5.3  Checking Hardware Status

Verifying the Hardware Status is always the first step in troubleshooting a wireless connection 
issue.

The Hardware Status indicators in the lower-right corner of the Home screen provide a quick 
reference to wireless operations. The background color of the status indicator icon represents the 
condition of the wireless connectivity to that device. Icon status is shown in the table below:

The three light emitting diodes (LEDs) on the faceplate of the Scan Module let you know at a 
glance whether or not there is an active connection between the two modules. The two green 
LEDs (Vehicle Power and Bluetooth) both flash on and off when the Scan Module and diagnostic 
tool are actively communicating through a wireless connection. The red Communication LED 
flashes on and off when the Scan Module is performing an internal self test, and is illuminated 
continuously if a failure is detected (Figure 5-6).

Hardware 
Icon

Background 
Color Condition Action

Red Not Paired
Pair the Scan Module to the diagnostic tool. See 
Pairing The Scan Module on page 55 for 
instructions.

Grey
Paired, but Not 
Communicating

You may have moved out of range. Move the 
diagnostic tool closer to the Scan Module to 
reestablish communications. If connectivity is 
not restored, perform the Recovery 
Procedure on page 61.

Blue
Paired and 
Communicating

Hardware status is good and Bluetooth should 
be functional. Verify that the green Bluetooth 
LED on the front of the Scan Module is flashing. 
If there is no connectivity, perform the 
Recovery Procedure on page 61.

Green USB Cable Connected Indicates the USB cable is connected.

Gray
USB Cable Not 
Connected

Indicates the USB cable is not connected or 
connected but not allowing communication
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1— Vehicle Power—green LED, flashes during wireless communications

2— Communication—red LED, illuminates if there is a communications failure

3— Bluetooth—green LED, flashes during wireless communications
Figure 5-6 Scan Module LEDs

Each LED can be in one of three states; off, lit solid, or flashing. Interpret as follows:

• Vehicle Power

– Off, vehicle power is not being supplied to the Scan Module through the data cable

– On Solid, the Scan Module is being powered by the vehicle, but not communicating with 
the Diagnostic Tool.

– Flashing, the Scan Module is being powered by the vehicle and is communicating with the 
Diagnostic Tool.

• Communication

– Off, normal state, no errors detected.

– On Solid, communications error detected.

– Flashing, internal self-test in process, will go out once the test completes.

• Bluetooth

– Off, there is no connection between the Scan Module and Diagnostic Tool.

– On Solid, the Scan Module and Diagnostic Tool are communicating through a solid 
(USB cable) connection.

– Flashing, the Scan Module and Diagnostic Tool are communicating through a wireless 
connection.
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5.5.4  Recovery Procedure

This is a quick and easy method that reestablishes connectivity between the diagnostic tool and 
the Scan Module in most instances. If bluetooth connectivity remains unavailable following 
recovery, use one of the alternate procedures to restart the system.

NOTE:
i This product is intended to be used by professional technicians in a garage environment. 

Electrostatic discharges may happen occasionally and cause a loss of communication. To restore 
communication disconnect and reconnect the communication cables and follow screen prompts.

z To recover wireless connectivity:

1. Disconnect the Scan Module from the vehicle.

2. Navigate to the Home Screen on the diagnostic tool.

3. Select Exit to close the ShopStream Diagnostic Suite.

4. Connect the Scan Module to the vehicle.

5. Select the ShopStream Diagnostic Suite icon on the desktop.

Figure 5-7 Sample ShopStream Diagnostic Suite desktop icon

NOTE:
i The ShopStream Diagnostic Suite can also be started from the Windows Start menu.

Alternate Recovery Procedures

Use these methods as an option to the Recovery Procedure, or when recovery fails to restore the 
wireless connection.

USB Procedure

This method establishes a “hard-wired” USB cable connection between the modules.

z To create a USB connection:

1. Carefully slip the ends of the handgrip off of the sides of the Scan Module housing.

2. Lift open the hinged cover on the base of the Scan Module.
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Figure 5-8 Scan Module USB jack, handgrip removed

3. Plug the small end of the USB cable into the USB jack on the Scan Module.

4. Plug the large end of the USB cable into a USB jack on the diagnostic tool.

Scanner functionality should be restored immediately once the USB connection is complete. 
If not, suspect a hardware failure. The diagnostic tool and Scan Module are both fully 
functional, so you can complete your testing with the USB connection intact.

ShopStream Diagnostic Suite Restart Procedure

This method, which closes and restarts the ShopStream Diagnostic Suite software, takes about 
two minutes to complete.

z To restart the ShopStream Diagnostic Suite:

1. Navigate to the Home Screen on the diagnostic tool.

2. Select Exit to close the ShopStream Diagnostic Suite.

3. Wait for the Scan Module Communication LED to stop flashing.

4. Select the ShopStream Diagnostic Suite icon on the desktop.

The ShopStream Diagnostic Suite should open with connectivity restored.

Windows Reboot Procedure

This method, which completely shuts down the diagnostic tool, takes several minutes to complete.

z To reboot the diagnostic tool:

1. Disconnect the Scan Module from the vehicle.

2. Navigate to the Home Screen on the diagnostic tool.

3. Select Exit to close the ShopStream Diagnostic Suite.

4. Select Start in the lower-left corner of the screen to open the menu.

5. Select Turn Off Computer from the menu.

6. Select Turn Off when the Confirmation window opens.

7. Wait for the tool to completely turn off, then press the Power button to restart the diagnostic 
tool.

8. Connect the Scan Module to the vehicle once the ShopStream Diagnostic Suite opens.



63

Scan Module Operation Updating Scan Module Firmware

5.6   Updating Scan Module Firmware
The internal programming (firmware) of the Scan Module, may require periodic updates. These 
firmware updates (when available) are delivered with diagnostic software updates/upgrades. 
Firmware updates increase the Scan Module’s diagnostic capabilities, typically by adding support 
for new tests, vehicles and enhanced applications to the vehicle databases. 

z Scan Module Firmware Update Process:

Upon starting the Scanner function, initially after a software update or upgrade has been installed, 
a message may be displayed to inform you an update is available (Figure 5-9).

Figure 5-9 Scan Module update available message

IMPORTANT:
To supply power to the Scan Module, the data cable must be connected to the vehicle during the 
update process, with the vehicle ignition switch in the OFF position. To avoid damaging the Scan 
Module, never turn the ignition switch ON during the update process.

IMPORTANT:
To avoid damaging the diagnostic tool or scan module, it is highly recommended to connect the 
AC/DC power supply to the diagnostic tool before starting the firmware update process. Damage 
can occur to the scan module if the diagnostic tool power is turned off or the power supply is 
disconnected during the firmware update process.

1. Select the desired update option:

• Update Now begins the process immediately.

• Update Later defers the operation, closes the message, and starts the Scanner function. If 
you choose not to perform the update, it will not affect diagnostic tool operation, however you 
will not benefit from the additional features available in the update.

NOTE:
i Selecting Details in the upper-right corner opens a list of what is included in the update.

Once the update process has been started, the update is performed wirelessly, and the installation 
progress is tracked on the screen (Figure 5-10).
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Figure 5-10 Sample update in progress screen

A “successfully updated” message displays once the installation process is complete 
(Figure 5-11).

Figure 5-11 Sample firmware update complete message

2. Select OK to close the message and return to Scanner operations.

The updated Scan Module, is ready to use.

z Alternate Scan Module Firmware Update Process (USB cable):

If necessary, this alternate firmware update procedure may be used to update the Scan Module 
firmware.

IMPORTANT:
The diagnostic tool must be connected and powered by the AC/DC power supply during the Scan 
Module firmware update process. Damage can occur to the Scan Module if the diagnostic tool 
power is turned off or the power supply is disconnected during the firmware update process.

1. Connect the AC/DC power supply to the diagnostic tool. 

2. Turn on the diagnostic tool.

3. Connect the Scan Module to the diagnostic tool as follows:
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IMPORTANT:
The Scan Module data cable must be disconnected from the vehicle during the update process.

a. From the bottom of the Scan Module, gently lift up and out on the sides of the handgrip to 
free it from housing (Figure 5-12).

b. Open the hinged cover on the base of the Scan Module to expose the USB jack.

c. Plug the small end of the USB cable into the USB jack on the Scan Module.

d. Plug the large end of the USB cable into one of the USB jacks on the side of the 
diagnostic tool.

NOTE:
i When connected, the scan module USB connection status icon background color will change from 

gray to green.

1— Hinged cover

2— USB jack
Figure 5-12 Scan Module USB jack

4. Select Scanner from the diagnostic tool Home screen.

5. Select OK when the update available message displays.

The update begins and installation progress is tracked on the screen (Figure 5-13).

Figure 5-13 Sample update in progress screen
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A “successfully updated” message displays once the installation process is complete 
(Figure 5-14).

Figure 5-14 Firmware update complete message

6. Select OK to close the message and return to the Scanner function.

The updated Scan Module, is ready to use.
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This Home screen option allows you to access Generic OBD-II/EOBD Scanner tests without 
completing a vehicle identification. OBD Direct presents a quick way to check for diagnostic 
trouble codes (DTCs), isolate the cause of an illuminated malfunction indicator lamp (MIL), check 
monitor status prior to emissions certification testing, verify repairs, and perform a number of other 
services that are emissions-related. This mode is also used for testing OBD-II/EOBD compliant 
vehicles that are not included in the Scanner databases.

OBD Direct is a Scanner function, and the Scan Module must be connected to the test vehicle and 
communicating with the diagnostic tool. This function only provides generic OBD-II/EOBD 
information. To access enhanced OBD-II/EOBD functions, select Scanner from the Home screen.

Options for the Menu icon on the Toolbar at the base of the screen are the same as those available 
for the Scanner module. 

Selecting OBD Direct on the Home screen opens a menu with two options (Figure 6-1):

Figure 6-1 Sample OBD Direct main menu
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6.1   OBD Health Check
The OBD Health Check offers a way to quickly check for and clear generic diagnostic trouble 
codes (DTCs) and to check readiness monitors. Selecting OBD Health Check opens a submenu 
of options (Figure 6-2).

Figure 6-2 Sample OBD Health Check menu

6.1.1  Global OBD II Code Check

This option displays any stored emission related generic DTCs reported by the ECM. Selecting 
opens a submenu with two choices:

• Codes

• Pending Codes

Codes

Codes displays a list of current emission related DTCs. OBD-II/EOBD Codes have a priority 
according to their emission severity, with higher priority codes overwriting lower priority codes. 
The priority of the code determines the illumination of the MIL and the code erase procedure. 
Manufacturers rank codes differently, so expect to see differences between makes.
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Pending Codes

The purpose of this service is to enable the scan tool to obtain “pending” or maturing diagnostic 
trouble codes. These are codes whose setting conditions were met during the last drive cycle, but 
need to be met on two or more consecutive drive cycles before the DTC actually sets.

The intended use of this service is to assist the service technician after a vehicle repair and after 
clearing diagnostic information, by reporting test results after a single driving cycle.

• If a test failed during the driving cycle, the DTC associated with that test is reported. If the 
pending fault does not occur again within 40 to 80 warm-up cycles, the fault is automatically 
cleared from memory.

• Test results reported by this service do not necessarily indicate a faulty component or system. 
If test results indicate another failure after additional driving, then a DTC is set to indicate a 
faulty component or system, and the MIL is illuminated.

6.1.2  Global OBD II Clear Codes

This option is used to clear all emission related diagnostic data such as, DTC records, freeze 
frame data, and test results, from ECM memory. Although OBD Direct only displays generic 
OBD-II data, clearing codes erases all of the stored data including any enhanced codes.

A confirmation screen displays when the clear codes option is selected to prevent accidental loss 
of data. Select Yes on the confirmation screen to continue.

6.1.3  Readiness Monitors

Use this menu option to check the readiness of the monitoring system. An OBD-II/EOBD system 
checks the status of emission-related subsystems by running continuous or periodic tests. Test 
results are shown in the data viewer (Figure 6-3).

Figure 6-3 Sample readiness monitor test report

Gesture sweep to view the entire list of Readiness Monitors to ensure that all tests are complete. 
It is possible to print the readiness test status or save it as part of a Vehicle history.
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6.1.4  MIL Status

This item is used to check the current condition of the malfunction indicator lamp (MIL). Additional 
information, such as which ECM commanded the MIL on and the distance driven while the MIL is 
on (if supported), can also be displayed. It is also possible to print the MIL Status.

6.2   OBD Diagnose
Selecting OBD Diagnose opens a menu with the following options:

• Start Communication—begins the test session

• Connector Information—provides data link connector (DLC) location details for most models

• Manual Protocol Selection—allows you to select which protocol to use

6.2.1  Start Communication

Use the following procedure to conduct an OBD Direct test session:

z To perform an OBD Direct Test:

1. Select Start Communications from the OBD Direct menu.

A generic connection message displays (Figure 6-4), connect the Scan Module to the 
test vehicle as instructed.

Figure 6-4 Sample generic connection message
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2. Select Continue.

A communications message that shows how many ECMs were detected, which ECM is 
communicating, and which communication protocol is being used displays (Figure 6-5).

Figure 6-5 Sample communication message

3. Select Continue and a menu of available tests displays (Figure 6-6).

Figure 6-6 Sample Start Communication menu

4. Select a test to continue.
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Readiness Monitors

Use this menu item to check the status of the monitored system. If a monitored system is not 
supported, it is not displayed. Scroll, if needed, to view the entire list of monitors. Selecting 
Readiness Monitors opens a submenu with two choices:

• Monitors Complete Since DTC Cleared—displays the results of all monitor tests that have 
run since the last time the electronic control module (ECM) memory was cleared.

• Monitors Complete This Cycle—displays only the results of monitor tests that ran during the 
current drive cycle, they reset when the ignition is switched off. 

MIL Status

This item is used to check the current condition of the malfunction indicator lamp (MIL). Additional 
information, such as which ECM commanded the MIL on and also the distance traveled while the 
MIL is on (if supported), can also be displayed. It is also possible to print the MIL Status.

Fast-Track Troubleshooter

Fast-Track® Troubleshooter is a database of experience-based information of validated 
real-world repair strategies that have been compiled by top-notch technicians since 1988. The 
Troubleshooter system simplifies the diagnosis process, as it contains information on virtually all 
common diagnostic trouble code (DTC) problems and driveability symptoms for most vehicles 
covered by the vehicle communication software.

($01) Display Current Data

Use this item to display the current emission related data from the selected electronic control 
module (ECM) of the vehicle. Displayed data includes analog inputs and outputs, digital inputs and 
outputs, and system status information broadcast on the vehicle data stream. OBD Direct data 
displays similar to Scanner data, refer to Data Display on page 43 for details.

($02) Display Freeze Frame Data

This item is used to display freeze frame data for any stored emission related diagnostic trouble 
codes (DTC). In most cases the stored frame is the last DTC that occurred. Certain DTCs, those 
that have a greater impact on vehicle emission, have a higher priority. In these cases, the highest 
priority DTC is the one for which the freeze frame records are retained.

Freeze frame data includes a “snapshot” of critical parameter values at the time the DTC set.

($03) Display Trouble Codes

This option displays any stored emission related DTCs reported by the various ECMs. The OBD 
Direct code report is similar to a Scanner module code report, and includes the Fix It! icon with 
hyperlinks to  Information details. See Display Codes on page 47 for additional information.
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($04) Clear Emissions Related Data

This item is used to clear all emission related diagnostic data such as, DTCs, freeze frame data, 
and test results from the memory of the selected ECM.

($05, 06, 07) Display Test param./Results

This option opens a submenu of test parameters and test results from various sensors, monitor 
test results, and a record of DTCs detected during the last drive cycle. The menu includes:

• Oxygen Sensor Monitoring ($05)

• On-Board Monitored Systems ($06)

• DTCs Detected During Last Drive ($07)

($08) Request Control of On-board System

This service enables bidirectional control of the ECM so that the Scanner is able to transmit 
control commands to operate the vehicle system. This function is useful in determining how well 
the ECM responds to a command.

Available options vary by make, model, and year of the test vehicle. Select a test and follow the 
on-screen instructions.

($09) Read Vehicle Identification

This selection displays the vehicle identification number (VIN), the calibration identification, and 
the calibration verification number (CVN) of the test vehicle.

($09) In-use Performance Tracking

This selection displays the “In-use Performance Tracking” of monitored data. It is basically a 
record of the number of times each of the monitor tests have been completed.

($0A) Emission Related DTC with Permanent Status

This service displays a record of any “permanent” codes on late-model vehicles if the vehicle 
supports Service $0A. A permanent status DTC is one that was severe enough to illuminate the 
MIL at some point, but the MIL may not be on at the present time.

Whether the MIL was switched off by clearing codes or because the setting conditions did not 
repeat after a specified number of drive cycles, a record of the DTC is retained by the ECM. 
Permanent status codes automatically clear after repairs have been made and the related system 
monitor runs successfully.
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6.2.2  Connector Information

This option opens a database of vehicle diagnostic connector locations that includes most makes 
and models.

z To locate a vehicle diagnostic connector:

1. Select Connector Information from the System menu.

2. Select a manufacturer from the list presented.

3. Select a model from the list presented.

Instructions for which, if any, cable adapter or pin to use displays.

4. Select Continue.

Information on where to locate the vehicle diagnostic connector displays.

5. Select Continue to return to the System menu.

6.2.3  Manual Protocol Selection

A communication protocol is a standardized way of data communication between an ECM and a 
scan tool. Global OBD may use several different communication protocols. The scan tool 
automatically connects to an available protocol, which displays on the connection message 
(Figure 6-5). Some vehicles communicate on more than one protocol. Use the Manual Protocol 
Selection option to switch to a different protocol.

Select Manual Protocol Selection and message displays advising you to make sure you know 
the correct protocol for the test vehicle. An incorrect selection may activate warning lamps and set 
CAN related faults on the vehicle. Select OK and a menu of options displays (Figure 6-7).

Figure 6-7 Sample communication protocol menu
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The Guided Component Test software is a component-testing powerhouse, providing you with a 
robust diagnostic database for use with scopes and meters. It is like having access to a complete 
library of shop manuals for testing engine-management components, transmission sensors and 
components, and ABS systems.

Guided Component Test helps you with everything from selecting the appropriate test for a 
specific component to showing the hook-up location and correct pin configuration. This software 
thoroughly guides and instructs you on proper testing procedures and offers tips from the internal 
troubleshooter database. The Guided component test procedures, tips, and meter settings reduce 
your overall set-up and diagnostic testing time. Vehicle-specific guided component tests are 
provided for engine, transmission, ABS, charging, transfer case and suspension systems.

Risk of electrical shock.
• Read the Important Safety Instructions document provided separately for messages on 

the safe use of this product.
• This product is intended for Measurement Category I (for example, automotive 12V 

systems), do not use this product for Measurement Categories II, III, and IV.
• Measurement Category I is for performing measurements on circuits not directly 

connected to MAINS or MAINS circuits (an example of a MAINS circuit is 120V AC or 
240V AC household or industrial electricity), do not connect this product to MAINS or 
MAINS circuits.

• Do not apply the Black Ground Lead to test points other than ground/system return/
vehicle chassis.

Electrical shock can cause personal injury, equipment damage, or circuit damage.

IMPORTANT:
Maximum rated transient over voltage impulse is 500 volts, do not exceed the rated 
transient over voltage.

7.1   Vehicle Identification
The Guided component test information presented is specific to the vehicle being tested. 
Therefore, certain attributes of the test vehicle must be entered into the diagnostic tool so that the 
correct data can be retrieved. Vehicle identification information is carried over if you enter the 
Guided Component Test module either from the Scanner function or from one of the records 
stored in the Vehicle History module. However, you may need to enter additional attributes in 
some instances.

The vehicle identification sequence is menu driven, you simply follow the screen prompts and 
make a series of choices. Each selection you make advances you to the next screen.
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7.1.1  Menu Options, Guided Component Test

Selecting the Toolbar Menu icon at the base of the screen offers the following options:

• Safety Information—opens the Important Safety Instructions document.

• File—allows you to print or save the data being viewed.

• Top Level Menus—allows you to access supplemental information and training programs.

• Help Operations—allows you to view supporting documentation.

File

Selecting File opens a menu of print options:

• Print Article—selecting has one of two results:

– If a printer is connected, the file is sent to the printer.

– If a printer is not connected, the article is saved as a (.xps) file, which can be retrieved, 
moved, or copied and printed at a later time.

• Print Preview—opens a representation of what the printed file will look like.

• Page Setup—allows you to adjust margins and paper orientation.

Top Level Menus

Selecting Top Level Menus opens a list that may include the following options:

• Power User Tests

• How To

• Features Benefits

• Index (United Kingdom Only)

Features Benefits

Selecting Features Benefits opens a menu page that includes:

• 5-Minute Walk Thru With Demo Board (Australia Only) —explains how to use the optional 
demonstration board to generate sample signals.

• Features & Benefits—provides descriptions and a brief overview of meter functions

• Accessories—opens a menu of optional equipment available.

• Product Description—provides descriptions and a brief overview of meter operations.

The demonstration board not only helps you learn how to use the Guided Component Tests 
software, it allows you to hone your skills and diagnostic technique without an actual test vehicle.

Index (United Kingdom Only)

Selecting Index opens an alphabetical list of components, systems, tests, terms, and other items 
for which there is a brief help file. Some items open an additional menu. Use the Back and Exit 
icons on the Toolbar to return or close the screen.



77

Guided Component Test Operations Vehicle Identification

Power User Tests

The Power User Tests option gives you quick access to a pre-configured meter for conducting a 
number of control system tests. Tests are available with or without on-screen help. Help typically 
provides a description of the test along with expected results and a link to the pre-set meter.

How To

The How To option provides a list of available on-screen instructions for performing tasks. Scroll 
to view the entire list. Typical topics include:

• 10-Minute Battery Drain Class—covers battery draw basics.

• 10-Minute Electronic Class—provides brief instruction in basic electronics and circuit 
connections.

• 10-Minute High Intensity Discharge Lighting Class—provides brief instruction on high-
intensity lighting system basics.

• 10-Minute Lin Bus Class—provides brief instruction on LIN BUS systems.

• 15-Hybrid Vehicle CLASS—provides a brief overview of hybrid vehicle systems.

• 15-Minute Ignition Class—provides an introduction to basic ignition testing.

• 15-Minute Mapped Cooling System Class—provides a basic system overview.

• 15-Minute Tyre Pressure Monitoring System Class—provides a basic system overview.

• 15-Minute Voltage Drop Diagnosis Class—covers performing voltage drop tests and using 
the results to diagnose circuit failures.

• 15-Minute Lin Bus Class—provides brief instruction on LIN BUS systems.

• Illustrated Terms & Definitions—provides definitions of terms, drawings and tips associated 
with guided component testing.

• No-start Basics—provides a guideline for diagnosing a no-start condition.

• O2 Sensor & Feedback System Analysis—displays the guided component test meter in the 
“live” graphing mode with O2S test tips to help you understand the fundamental concepts of 
O2S diagnostics.

• Test Tips—gives on-screen instructions for performing specific guided component tests along 
with drawings and tips.

• 20-minute Current Ramp Classes—provides an introduction to current ramp testing.

7.1.2  Creating a Favorites List

Once a Guided Component Test database is loaded, a list of manufacturers displays. This list is 
often long and includes makes that are not frequently used. A toolbar at the top of the screen 
allows you to custom configure the manufacturer list to display only the makes you frequently 
service.
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Figure 7-1 Sample manufacturer list

z To configure a favorites list:

1. Select Configure Favorites on the toolbar.

A list of selectable manufacturers displays.

Figure 7-2 Sample Configure Favorites screen

2. Select each manufacturer you want to include, selected manufactures are highlighted.

NOTE:
i Manufacturers appear on the favorites list in the order in which they are selected. Therefore, if you 

select the makes you work on most frequently first, they will appear at the top of the list.

3. Select Finished on the toolbar once your selections have been made.

The screen returns to the manufacturer list, but only the makes you selected display. Note the 
“Favorites” toolbar selection now reads “Full list”.
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4. Select Full List on the toolbar to view the complete list of manufacturers.

5. Select Back on the toolbar at any time to return to the previous screen.

Your favorites list is what will display whenever a Guided Component Test database is started in 
the future. The list can be modified at any time by selecting Configure Favorites from the toolbar.

7.1.3  Identifying a Test Vehicle

Exact procedures to identify the test vehicle may vary somewhat by vehicle and market. The 
following procedure, which identifies a 2008 Ford Focus for testing the fuel injection system, is 
typical of what to expect.

z To identify a vehicle for Guided Component Test:

1. Select the Guided Component Test Function icon from the Home screen.

2. Select which database to load for the test vehicle if requested (optional).

After the database loads, a list of manufacturers displays.

3. Select FORD and a model year menu displays.

4. Select 2008 from the year menu and a list of available models displays.

5. Select FOCUS from the model list and a list of available engines displays.

6. Select 1.6L from the engine list and a confirmation dialog box displays (Figure 7-3).

Figure 7-3 Sample confirmation dialog box

7. From the confirmation dialog box, select OK to continue, or Cancel to return to the engine list.

A list of tests available for the identified vehicle displays (Figure 7-4).
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Figure 7-4 Sample available tests list

8. Select ENGINE and a component test menu displays (Figure 7-5).

Figure 7-5 Sample available component tests list

9. Select a test to continue.

The identification sequence is now complete, refer to the Operations section that follows for 
details on how to navigate through the Guided Component Test information and perform tests.

NOTE:
i If you return to the Home screen and select Scanner or Vehicle History the vehicle identification 

entered here is carried over. However, additional information may be needed by some modules.
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7.2   Operations
The Guided Component Test software provides vehicle specific guided component test 
procedures and information that aid in setting up scopes and meters. Once a test vehicle is 
identified, you can select a guided component test from the list of available tests. For most 
selections two main choices are available on the component menu:

1. COMPONENT INFORMATION—provides information on the selected component and 
connector pin details that assists you in understanding the components prior to diagnosis.

2. TESTS—provides a pre-configured list of tests, guides you through performing the tests, and 
offers tips and resources to reduce setup and testing time.

7.2.1  Component Information

Component Information provides details on specific vehicle components to provide a better 
understanding of the components prior to diagnosis.

The Component Information screens contain information to assist you with testing. The screens 
are divided in sections to help quickly guide you to the correct information (Figure 7-6):

• Operation—provides a general description of normal component operation.

• Connector—displays the component connector and lists pin assignments.

• Location—identifies the component location and the best place for testing it.

• Tech note—provides guided component test-related tips (for example, common failures or 
faults) as well as update or recall information.

Figure 7-6 Sample Component Information screen

z To view component information:

1. Select a component from the tests list.

2. Select COMPONENT INFORMATION from the component menu.
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NOTE:
i An additional selection, such as front or rear for an oxygen sensor (O2S), may be required before 

advancing to the component information screen.

The component information screen displays (Figure 7-6).

3.  Always Gesture sweep to view any additional information below what is visible.

4. Select Back at any time to return to the previous screen.

7.2.2  Tests

The Tests section guides you through the process of performing tests on a specific component. It 
also provides specifications, tips on how and where to connect the test meter leads, and also 
automatically configures the multimeter or lab scope to perform the selected test.

Once a test vehicle is identified, you can select a component from the available tests list.

z To select a test:

1. Select a component from the list.

2. Select TEST to open the list.

NOTE:
i More than one selection is available in some instances. For example, select Ignition Tests and a 

menu offering Primary Tests and a Secondary Tests displays.

The list shows all of the tests available for the selected component, choices vary by make, 
model, and year.

Selecting opens an additional submenu similar to the one shown in Figure 7-7 when more 
than one option is available.

Figure 7-7 Sample O2S voltage test submenu
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3. Select a test option and the test screen displays (Figure 7-8).

Figure 7-8 Sample Test screen

4. Gesture sweep to view any additional information.

5. Select Back at any time to return to the previous screen, or select Exit to return to the main 
component menu.

Hyperlinks

Guided component test screens contain hyperlinks that can either take you to another page 
containing additional information or open an additional window on top of the current screen. 
Hyperlinks display as icons. Common hyperlinks are:

– View Meter—opens a live meter set up to perform the test in the lower portion of the 
screen (Figure 7-9). Once the meter view is open, the Guided Component Test toolbar at 
the top of the screen is replaced by the Scope Multimeter toolbar, which allows you to 
make adjustments to the settings. See Scope Multimeter Toolbar on page 93 for details.

– Show More Information—advances to a new screen with more detailed information 
about a particular test, select Back to return to the test screen.
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View Meter

A Meter icon, which is only available in the Guided Component Test view meter mode, appears on 
the upper toolbar (Figure 7-9).

Figure 7-9 Sample view meter window

Three view meter options are available:

1. With View Meter active (Figure 7-9), select the Meter icon on the toolbar once and the meter 
expands to fill the entire screen.

2. Select the Meter icon a second time and the meter open as a separate window (Figure 7-10). 
This window can remain open if you switch to the Scanner function and can be accessed from 
the Windows toolbar at the bottom of the screen. You can also resize and reposition the meter 
window on the screen.

Figure 7-10 Sample meter view in a separate window
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Selecting the Close icon (red box with an X) when viewing the meter in a separate window 
closes the meter and returns you to the Guided Component Test screen.

3. Select the Meter icon a third time to close the separate window and return to the standard 
meter view as shown in Figure 7-9.

Select Exit from the toolbar to close meter view and return to the Guided Component Test 
screen.

Connecting to a Test Vehicle

Before performing a test, you must connect the meter test leads to the vehicle. Certain guided 

component tests require the use of specific leads. Information on specific leads and other 
connecting information displays on the initial test screen. Follow the on-screen connection 
instructions in the test procedure to connect the test leads.

Performing a Test

Once you connect the test leads to the vehicle, you can proceed with testing.

z To perform guided component tests:

1. Follow the instructions displayed in the test procedure section.

2. Gesture sweep to view all of the instructions and follow the on-screen procedures.

3. Select the View Meter hyperlink to display test results.

4. Refer to the on-screen information to verify test results.

IMPORTANT:
Refer to Operations on page 131 for additional information on working with the View Meter 
window.
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This Scope Multimeter module provides all the tools needed for performing electrical and 
electronic circuit tests and for monitoring signals and circuit activity. The Scope Multimeter works 
interactively with other modules. Selecting “View Meter” from a Guided Component Test or 
Scanner Test starts the Scope Multimeter module.

Risk of electrical shock.
• Read the Safety Information provided for important warnings on the use of this product
• This product is intended for Measurement Category I (for example, automotive 12V 

systems), do not use this product for Measurement Categories II, III, and IV.
• Measurement Category I is for performing measurements on circuits not directly 

connected to MAINS or MAINS circuits (an example of a MAINS circuit is 120V AC or 
240V AC household or industrial electricity), do not connect this product to MAINS or 
MAINS circuits.

Electrical shock can cause personal injury, equipment damage, or circuit damage.

IMPORTANT:
Maximum rated transient over voltage impulse is 500 volts, do not exceed the rated 
transient over voltage.

8.1   Getting Started
The Scope and Multimeter module enables the following functions:

• Lab Scope

• Ignition Scope

• Graphing Multimeter

• Digital Multimeter

8.1.1  Capabilities

The following tables detail the software and hardware capabilities.

NOTE:
i 200V to 400V scales are not to be used to measure signals greater than 50VAC (rms) or 75VDC.

IMPORTANT:
Do not use the Low Amp Probe to measure current on conductors at a potential greater than 
46VAC peak or 70VDC.
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Table 8-1 Scope

Function Range Accuracy/Comments

Signal Measurement

Ch. 1—yellow banana jack
Ch. 2—green banana jack
Ch. 3—blue banana jack
Ch. 4—red banana jack

Each channel input is referenced to 
common ground input (GND—black banana 
jack)

Sample Rate

Single trace mode = 6 MSPS (Ch. 
1 only)
Dual trace mode = 3 MSPS (Ch. 1 
& 2 only)
Four trace mode = 1.5 MSPS (Ch. 
1–4)

Continuous sampling,
MSPS = mega samples per second

Bandwidth DC–3 MHz 3 db point @ 3 MHz

Input Impedance
10 MOhm@ DC
4 kOhm @ 3 MHz

Channel 1–4

VDC (Full Scale) 100mV–400V Do not measure greater than 75VDC

VAC (Full Scale) 100mV–400V Do not measure greater than 50VAC (rms)

Table 8-2 Graphing Multimeter

Function Range Accuracy/Comments

Signal Measurement

Ch. 1—yellow banana jack
Ch. 2—green banana jack
Ch. 3—blue banana jack
Ch. 4—red banana jack

Each channel input is referenced to 
common ground input (GND—black banana 
jack)

Sample Rate 1.5 MSPS
Continuous sampling,
MSPS = mega samples per second

Bandwidth DC–3 MHz 3 db point @ 3 MHz

Input Impedance
10 MOhm@ DC
 4 kOhm @ 3 MHz

Channel 1–4

VDC (Full Scale) 75VDC Do not measure greater than 75VDC

VAC (Full Scale) 50VAC Do not measure greater than 50VAC (rms)

Low Amp Probe
20A scale (100mV/Amp)
40A scale (10mV/Amp)

Connect Low amp Probe (+) to Ch. 1 
(yellow banana jack) and (–) to GND input 
(black banana jack).
See NOTE below.

Table 8-3 Digital Multimeter

Function Range Accuracy/Comments

Signal Measurement Ch. 1—yellow banana jack
Channel 1 input is referenced to common 
ground (GND—black banana jack)

VDC (Full Scale) 75VDC Do not measure greater than 75VDC

VAC (Full Scale) 50VAC Do not measure greater than 50VAC (rms)

Signal Measurement 
Input Impedance

10 MOhm

Ohm Measurement 
Diode Test 
Continuity Test

Ch. 3—blue banana jack
Ch. 4—red banana jack

Each channel input is referenced to 
common ground (GND—black banana jack)

Ohms 400 Ohm–4 MOhm Fixed scales or Auto Ranging

Glitch capture Approximately 50 uS

Diode Test 2 V Scale
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8.1.2  Leads, Probes and Adapters

The Scope Multimeter uses standard safety banana plugs that are compatible with many 
accessories. The various leads, probes, clips, and adapters that are supplied with or available for 
the Diagnostic Tool explained in this section.

IMPORTANT:
When removing leads from their sockets, do not pull on the wire because it can damage the leads. 
Pull on the plug.

Channel 1 Lead

Figure 8-1 Yellow Channel 1 Lead

The shielded yellow lead is used for Channel 1 (Figure 8-1) and other channel connections that 
need additional grounding. The lead color matches the color of socket 1 on the diagnostic tool and 
the color of trace 1 on the test screens.

This yellow lead includes a black, right-angle, common ground plug and a black, stackable, 
right-angle, common ground plug. The non-stackable ground plug always connects to the ground 
(GND) jack on top of the diagnostic tool. The stackable ground plug is used for connecting 
additional leads, such as the Channel 2 Lead or the Secondary Coil Adapter Lead, that require 
grounding. The stackable lead does not need to be connected to the GND jack on the diagnostic 
tool, it grounds through the non-stackable lead.

Channel 2 Lead

Figure 8-2 Green Channel 2 lead

The shielded green lead (Figure 8-2) is used for Channel 2. The lead color matches the color of 
socket 2 on the diagnostic tool and the color of trace 2 on the test screens. This green lead 
includes a stackable, black, right-angle, ground plug.
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Channel 3 Lead 

Figure 8-3 Blue Channel 3 lead

The non-shielded blue lead (Figure 8-3) is used for either Channel 3 or Digital Meter minus (–). 
The lead color matches the color of socket 3 on the diagnostic tool, as well as the color of trace 3 
on the test screen.

Channel 4 Lead

Figure 8-4 Red Channel 4 lead

The non-shielded red lead (Figure 8-4) is used for either Channel 4 or Digital Meter plus (+). The 
lead color matches the color of socket 4 on the diagnostic tool, as well as the color of trace 4 on 
the test screen.

Alligator Clips

Figure 8-5 Alligator clip

Four insulated alligator clips are included and colored to match each test lead, a black clip for the 
common ground lead is also supplied (Figure 8-5). Each clip plugs into the straight end of a 
channel lead.

Test Probes

Figure 8-6 Test probe

Two test probes are included, one black and one red (Figure 8-6) and plug into the straight end of 
the test leads.
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Secondary Coil Adapter Lead (optional)

Figure 8-7 Secondary Coil Adapter lead

The optional Secondary Coil Adapter lead (Figure 8-7) connects to the clip-on secondary wire 
adapter, coil-in-cap adapter or coil-on-plug adapter to display secondary waveforms.

Secondary Ignition Clip-on Wire Adapter (optional)

Figure 8-8 Secondary Ignition Clip-on Wire Adapter

The optional Secondary Ignition Clip-on Wire Adapter (Figure 8-8) connects the Secondary Coil 
Adapter lead to the vehicle Secondary wire to display ignition patterns.

Inductive RPM Pickup Adapter (optional)

Figure 8-9  Inductive RPM Pickup adapter

The optional Inductive RPM Pickup adapter (Figure 8-9) connects to the scope auxiliary jack of 
the diagnostic tool with a DB9F plug. It can be used to trigger a waveform or display RPM. With 
the Ignition Scope, the RPM Pickup connects to cylinder number one to establish the firing order.
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Low Amp Current Probe (optional)

The optional Low Amp Current Probe provides accurate and reliable non-intrusive testing of 
ignition coils, fuel injectors, fuel pumps, relays, electric motors, and parasitic draw. The optional 
Low Amp Current Probe measures current from 10 mA to 60 Amps.

Figure 8-10 Low Amp Current Probe

8.1.3  Menu Icon Options, Scope Multimeter

The Menu icon on the Toolbar at the base of the screen opens a menu with the following options:

• Safety Information—opens the Important Safety Instructions document.

• File—allows you to print or save the data or meter setup being viewed.

• Setup—allows you to adjust certain tool settings once a test has been selected.

• Help—allows you to view supporting documentation.

File

Use to print or save a copy of the data currently being viewed. Selecting opens a submenu:

• Save Multimeter—opens an additional submenu with these options:

– Save Configuration—saves the current screen setup as a preset for quick access.

– Save Single Frame—saves a recording of the current screen.

– Save All Frames—saves a recording of the current screen plus all the data in the buffer.

• Print—opens a standard Windows Print dialog box for printing the current screen. A message 
will display asking if you wish to print only the scope or the entire screen display. Answering 
No will print the entire displayed screen.

Setup

This option allows you to adjust tool settings to your personal preferences. Selecting opens a 
menu of the following:

• Unit Setup—opens the Unit Setup dialog box to adjust trace and display settings

• Snapshot—opens the Snapshot dialog box for selecting how triggered data is saved.

• Ignition—opens the Ignition dialog box for setting up to display secondary ignition patterns.
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Help

A variety of utilities and additional resources are available through the Help menu:

• User Manual

• Version Info

• Activation Status

• Scope About

Scope About

This option opens a dialog box that contains the software version and other specific details about 
the Scope module. A Copy to Clipboard icon allows you to copy and paste the information to a 
document or e-mail.

8.2   Navigation
The following section describes how to navigate the screen interface.

8.2.1  Screen Layout
The screens typically include the following sections (Figure 8-11):

• Scope Multimeter Toolbar—allows you to configure the tool for the type of test and to adjust 
the settings for each channel, or trace.

• Main Body of the screen—displays test results. Options on the toolbar let you select how 
tests display on the screen.

• Trace Details—displays trace settings, which can be adjusted or switched through the touch 
screen.

• Record/Playback Control Toolbar—allows you to record and navigate through paused data.
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1— Scope Multimeter Toolbar

2— Main Body

3— Trace Details

4— Record/Playback Control Toolbar
Figure 8-11 Scope Multimeter screen layout

Scope Multimeter Toolbar

The Scope Multimeter toolbar is used to set up the tool for testing and to configure the settings for 
each trace. The table below gives brief descriptions of the control icons on the toolbar:

Table 8-4 Scope Multimeter toolbar icons (part 1 of 2)

Name Icon Description

Back Returns to the previously viewed screen.

Setup
Opens a dialog box that allows you to select 
personal preferences for viewing and saving data.

Data
Switches the trace information displayed at the base 
of the screen between three available states.

Cursors
Opens a dialog box that allows you to switch cursors 
on and off, and to reposition them on the screen.

Refresh Updates data on the viewing screen.
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Main Body of the Screen

The main body of the screen varies depending on what display options have been selected. Up to 
four traces, along with digital readouts of current signal values, signal status and triggering 
conditions, can be displayed simultaneously on the main body of the screen. Adjustments to the 
display are made through the scope toolbar as explained above.

Each trace is displayed as voltage over time on a standard oscilloscope screen. Voltage level is 
recorded on the vertical, or “y”, axis and time is presented on the horizontal, or “x”, axis of the 
screen. Values are shown for each graduation on the scales.

When using pressure transducers, the pressure being sensed is converted into a voltage signal. 
However, the values are shown as pressure on the display screen rather than voltage.

Trace Details

The Trace Details section displayed at the base of the screen can be used to quickly adjust 
settings for capturing the trace. The Trace details are accessed using either the Data icon on the 
upper toolbar or the Touch and Grow icon (fingerprint) icon on the Playback toolbar. Both icons 
function the same and cycle the Trace Details selection through three states:

• Displayed—trace settings are displayed in this mode

• Expanded—trace settings are displayed in a larger format in this mode

• Off—trace settings are not displayed in this mode

Adjustments are made by selecting the item to be changed on the screen. A dash (–) indicates a 
function that is not selected, and an icon displays to indicate an active function (Figure 8-12).

File
Opens a dialog box that allows you to select options 
for saving data.

Print
Opens a dialog box that allows you to configure and 
print data.

Power Off

Switches the Scope Multimeter off. This retains the 
settings and reduces battery drain when switching to 
a different module. The Play and Record icons on the 
Playback toolbar switch the meter back on.

Table 8-4 Scope Multimeter toolbar icons (part 2 of 2)

Name Icon Description
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1— Peak Detect on

2— Filter on

3— Inverted trace

4— Coupling AC on

5— Sweep setting

6— Trigger setup

7— Trigger set on the rising slope
Figure 8-12 Sample data detail display

The following trace adjustments and settings are available:

• Profile—switches the trace for the selected channel on and off.

• Channel—opens a dialog box that allows you to configure the trace setup (see Trace Controls 
on page 100 for details).

• Probe—opens a dialog box that allows you to select the type of test probe being used.

• Peak Detect—maximizes the signal sampling rate in order to capture fast events, such as 
spikes, glitches and other anomalies, that may normally be undetected.

• Filter—smooths out the trace when the signal is disrupted by noise or other interference.

• Inverted—switches the polarity of the displayed signal.

• Coupling AC—subtracts the average value of the waveform by blocking the DC portion of an 
input signal in order to amplify the AC portion. This allows small variations in the trace to 
become visible.

• Scale—opens a dialog box that allows you to select the scale, which is the total value 
displayed on the vertical axis of the display. The value shown in white at the bottom of the list 
is the current sweep setting, selecting it open a dialog box that allows you to adjust the sweep 
(see Sweep Controls on page 101 for details).

• Slope—only active when a trigger is set, indicates whether the trigger is set to activate on the 
rising or falling slope of the trace. Selecting the slope icon switches the slope. The white dash 
at the bottom of the slope column is used to set the trigger, selecting it opens the trigger setup 
dialog box (see Trigger Controls on page 102 for details).
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Record/Playback Control Toolbar

The record/playback control toolbar at the base of the screen is used for recording data and for 
reviewing paused data. Use the stylus or your finger tip to activate the icons. A position counter in 
the toolbar displays a numerical value of where the current screen is in relation to the entire 
recorded file.

Use the toolbar icons (Table 8-5) to navigate the data.

Table 8-5 Data buffer toolbar icons

Name Icon Description

Snapshot
Arms the software to take a snapshot of the sampled 
data

Step Back Moves to the previous point in the recorded data

Back 1 Frame Moves to the previous frame in the recorded buffer

Stop Stops recording data

Record Begins recording data

Play Recording
Plays the data recording in a continuous loop at 
actual speed

Forward 1 Frame Moves to the next frame in the recorded buffer

Step Forward Moves to the next point in the recorded buffer

Position Indicator

In record mode, indicates how much data is 
collected. In playback mode; shows the position of 
the buffered data currently displayed as 
minutes:seconds:milliseconds of elapsed time

Touch and Grow
Expands and collapses the Trace Detail area on the 
display screen to allow for easier finger tip control

Zoom Increase or decrease the magnification of the graph
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Use the slider in the middle of the toolbar to quickly move through paused data.

Figure 8-13 Sample data buffer slider

8.2.2  Making Selections

Most selections for setting up and operating the scope are made using the stylus and the scope 
toolbar. The cursor lines, the trace zero line, and the trigger point indicator (+) can be repositioned 
by selecting and dragging them in the main body of the screen.

There are two basic types of controls on the toolbar:

• Switches

• Dialog boxes

A Switch changes states when selected. Changes happen immediately as the selection is made.

A dialog box opens as a separate window on the screen and typically includes a number of 
choices. Changes happen immediately, however, the dialog box must be closed to return to the 
main window and continue. Make a selection to close the dialog box.

8.3   Operations
This section describes configuring the scope or meter and performing tests. Selecting “View 
Meter” from a Guided Component Test or Scanner screen saves time by automatically configuring 
the scope or meter.

8.3.1  Starting the Scope and Multimeter

Use the following procedure to set up the scope multimeter for performing tests.

z To start the scope multimeter:

1. Select the Scope Multimeter icon on the Home screen.

The Scope Multimeter main menu, a list of setup options, displays;

– Lab Scope

– Ignition Scope

– Graphing Meter

– Digital Multimeter

– Presets

2. Select the correct main menu option for the tests to be performed.

A submenu of scope or meter configuration displays, see below for additional information.

3. Select the correct configuration for the tests to be performed.

The Scope Multimeter displays configured for the selected test.
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Lab Scope Options

The following options are available for testing:

• 4 Channel Lab Scope

• Volts DC

• Low Amps (20)

• Low Amps (40)

• Low Amps (60)

• Ignition Probe

• 100 PSI Vacuum

• 100 PSI Pressure

• 500 PSI Pressure

• 5000 PSI Pressure

Graphing Options

The following options are available for testing:

• 4 Channel Graphing

• Volts DC

• Volts DC Average

• Volts AC RMS

• Frequency

• Pulse Width

• Injector Pulse Width

• Duty Cycle

• Low Amps (20)

• Low Amps (40)

• Low Amps (60)

• MC Dwell (60)

• MC Dwell (90)

• 100 PSI Vacuum

• 100 PSI Pressure

• 500 PSI Pressure

• 5000 PSI Pressure

Ignition Scope Options

The following options are available for testing:

• Parade

• Cylinder

• Raster

• Superimposed

• Single Cylinder Ignition
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Digital Multimeter Options

The following options are available for testing:

• Volts DC

• Volts DC Average

• Volts AC RMS

• Ohms

• Diode/Continuity

• Low Amps (20)

• Low Amps (40)

• Low Amps (60)

Presets

Presets are factory configured meter settings for common component tests. Selecting opens a list 
of available setups. Selecting from the list opens the scope multimeter configured to perform the 
selected test. In addition to the factory presets, you can create your own custom meter 
configurations and save them as presets.

8.3.2  Measurement Out of Range

A group of arrows display when a measurement is out of range for the scale selected:

• Arrows pointing UP—measurement over maximum range

• Arrows pointing DOWN—measurement under minimum range

Voltage measurements also display arrows in place of live values when the voltage exceeds the 
input rating of the meter.

Risk of electrical shock.
• Do not exceed voltage limits between inputs as indicated on the rating label.
• Use extreme caution when working with circuits that have greater than 40 volts AC or 

24 volts DC.
Electrical shock can cause personal injury, equipment damage, or circuit damage.

IMPORTANT:
If arrows are displayed in the live voltage values, discontinue circuit testing.

Correct an out-of-range condition by selecting a scale setting appropriate for the signal being 
sampled. See “Trace Controls” on page 100 for more information.

8.3.3  Scope and Multimeter Setup

The following sections explain how to adjust the scope and multimeter for the specific type of 
signal being sampled. Most of these setup operations are available from the toolbar.



100

Scope Multimeter Operations

Trace Controls

The Traces controls are used to adjust individual characteristics of how the signal is sampled and 
displayed for each of the four traces.

z To adjust trace controls:

1. Select Setup from the Scope Multimeter toolbar.

The Scope Multimeter Preferences dialog box opens.

2. Select Traces to open the submenu.

3. Select the tab for the trace to be configured from the submenu

The traces dialog box displays (Figure 8-14).

1— Trace tabs

2— Trace Probe icon

3— Trace Scale icon

4— Trace characteristics check boxes

5— Baseline position

6— Auto Find icon

7— Back icon

8— Exit icon
Figure 8-14 Traces dialog box

4. Select the Trace Probe icon to open the menu.

5. Highlight a probe on the list and select OK to close the window.

6. Select the Trace Scale icon to adjust the vertical scale, of the display.

A dropdown menu opens, menu options vary depending upon which test lead is selected.

7. Select a trace scale option, then close the window.

8. Select or deselect the trace characteristic items as needed:

– Displayed—this trace is on screen when checked, and not visible when not checked.

– Inverted—signal polarity is reversed when checked, normal when not checked.
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– Coupling AC—check when sampling an AC signal, uncheck for DC signals.

– Peak Detect—use when trying to capture a fast event or signal glitch.

– Filter—use when radio frequency interference (RFI) may be disrupting the signal.

9. The scope samples the signal and internally calculates the best way to display it when Auto 
Find is selected. A scale and the vertical position for the zero line of the trace that allows the 
whole waveform to fit on the screen is established when Auto Find is selected. If Auto Find is 
selected on the trigger channel, it also sets the trigger level halfway between the minimum and 
maximum value of the sampled signal to provide a stable waveform.

10. The baseline position is the zero line of the trace, use the slider and arrows to adjust it.

11. Select Back to return to the Preferences dialog box, or select Exit to close the dialog box and 
return to the scope.

Sweep Controls

Sweep is the amount of time represented by the screen, or the horizontal scale of the display.

z To adjust Sweep controls:

1. Select Setup from the Scope Multimeter toolbar.

The Scope Multimeter Preferences dialog box opens.

2. Select Sweep icon to open the sweep dialog box (Figure 8-15)

Figure 8-15 Sample Sweep Setup dialog box

3. Choose an option from the list.

4. Select Back to return to the Preferences dialog box, or select Exit to close the dialog box and 
return to the scope.
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Trigger Controls

Triggering allows you to set the scope so that it only begins displaying a trace once predetermined 
signal conditions, or triggers, are met. The trigger point is indicated by a plus sign (+) on the scope 
grid. The plus sign can be dragged across the grid with the stylus to roughly position it. The trigger 
controls allow you to precisely position the trigger.

z To adjust trigger controls:

1. Select Setup from the Scope toolbar The Scope Multimeter Preferences dialog box opens.

2. Select Trigger to open the Trigger Setup dialog box (Figure 8-16).

3. Use the dialog box controls to establish the position for triggering.

4. Select OK to close the dialog box.

5. Select Back twice to close the Scope Multimeter Preferences dialog box.

1— Source—selects the triggering event:

- Trace 1—sets the trigger to channel 1.

- Trace 2—sets the trigger to channel 2.

- Trace 3—sets the trigger to channel 3.

- Trace 4—sets the trigger to channel 4.

- Cylinder—sets triggering to the firing of a cylinder detected by the optional RPM 
Pickup or Secondary Ignition Adapter.

2— Mode—sets the method of triggering:

- Auto (automatic)—if a trigger is found, the waveform displays. If a trigger is not found 
after about a half second, the waveform and a “trigger not found” message displays.

- Manual—if a trigger is found, the waveform displays. If a trigger is not found nothing 
displays (no waveform and no message).

3— Slope—sets triggering to the rising (top icon) or falling (lower icon) slope of the signal 
waveform.

4— Vertical position—moves the trigger position up and down on the grid.

5— Horizontal position—moves the trigger timing left and right on the grid

6— Select Back to return to the Preferences dialog box, or select Exit to close the dialog box 
and return to the scope.

Figure 8-16 Trigger controls
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View Controls

Use the view controls to set display attributes.

z To adjust view controls:

1. Select Setup from the Scope Multimeter toolbar.

The Scope Multimeter Preferences dialog box opens.

2. Select View to open a submenu.

Three types of adjustment are available on the submenu:

– Display—use to adjust what information displays and how it appears

– Layout—use to set how many and how the traces display on the screen

– Units—use to adjust time and voltage interval settings

Selecting from the submenu opens a dialog box for that item. Dialog box options for each item 
are discussed in the following sections.

3. Make dialog box selections as needed.

4. Select Back to return to the Preferences dialog box, or select Exit to close the dialog box and 
return to the scope.

Display Settings

Selecting Display from the View submenu opens the Display dialog box (Figure 8-17).

Figure 8-17 Sample Display dialog box

The following options are available from the Display dialog box:

• Show RPM—adds an engine speed field at the top of the screen (Figure 8-18).

Figure 8-18 Sample Show RPM selected
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• Show Digital KV—available only in ignition scope, adds a kilovolt reading to the screen.

• Show Grid—switches grid lines on the screen off and on (Figure 8-19).

Figure 8-19 Sample grid selected

• Invert Colors—switches the screen background to white.

Layout Settings

The selected radio knob on the Layout dialog box shows which setting is active. Use a finger or the 
stylus to switch between settings:

• 1 window—shows all traces on the same screen (Figure 8-19).

• 2 windows—shows two separate traces in two ways: horizontal, one below another 
(Figure 8-20) or vertical, side-by-side (Figure 8-21)

Figure 8-20 Sample 2 Windows horizontal display
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Figure 8-21 Sample 2 Windows vertical display

• 3 windows—shows three traces, one below another, on the same screen (Figure 8-22).

Figure 8-22 Sample 3 Windows display

• 4 windows—shows four traces, one below another, on the same screen.
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Units Settings

The Units dialog box allows you to switch between Full Scale or Per Division settings for the trace 
setup and the display settings. Selecting Full Scale configures the units to the full viewing area of 
the screen, while Per Division adjusts the units to a single division (one tenth) of the screen.

The selected radio knob on the Units dialog box shows which setting is active. Use a finger or the 
stylus to switch between settings (Figure 8-23).

Figure 8-23 Sample View Units dialog box

Setup Controls

Basic tool settings are adjusted here.

z To adjust setup controls:

1. Select Setup from the Scope Multimeter toolbar.

The Scope Multimeter Preferences dialog box opens

2. Select Setup from the dialog box.

A submenu of options displays:

– Units—use to set how measurement values display, US standard or metric

– Snapshot—use to adjust the percentage of data captured following a trigger event

– Ignition—use to configure the optional ignition scope for the test vehicle

Selecting from the submenu opens a dialog box for that item. Dialog box options for each item 
are discussed in the following sections.

3. Make dialog box selections as needed.

4. Select Back to return to the Preferences dialog box, or select Exit to close the dialog box and 
return to the scope.

Unit Setup

The units of measurement can be changed between US standard or metric units of measure for 
pressure and vacuum readings. The table below shows available unit values.

Abbreviation Description

bar bar

inHg inches of mercury
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Selecting Units opens the Setup dialog box. The selected radio knobs on the Setup dialog box 
show which settings are active (Figure 8-24).

Figure 8-24 Sample Setup Units dialog box

Snapshot

The Snapshot tab of the Setup dialog box opens a window that allows you to select how much 
data is captured after a snapshot is triggered (Figure 8-25). Available selections, which range from 
ten to ninety percent in ten-percent increments, are shown as icons with the current setting 
highlighted. Select a icon, then select OK to close the dialog box.

Figure 8-25 Sample Snapshot dialog box

Refer to Trigger Controls on page 102 for information on how to setup a trigger.

kg/cm2 kilograms per centimeter squared

kPa kilopascal

mmHg millimeters of mercury

psi pounds per square inch

Abbreviation Description
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Ignition

The Ignition tab of the Setup dialog box is used to configure the scope for displaying secondary 
ignition patterns. There are two main selection fields (Type and Cylinders) and two fields that vary 
depending upon the type of ignition system selected in dialog box (Figure 8-26).

Figure 8-26 Sample Setup Ignition dialog box

z To setup Ignition tests

1. Select the Setup icon to open the Setup dialog box.

2. Select the Ignition tab of the dialog box.

3. Highlight the ignition system for the test vehicle in the “Type” field:

– Standard—use for systems with a distributor

– Waste Spark—use for coil pack systems that fire 2 plugs simultaneously

– Direct—use for coil-on-plug systems

– Other—use for systems that do not fit any of the above categories

4. Select the number of cylinders for the test vehicle in the “Cylinders” field.

Scroll through the list using the up and down arrows on either side of the number.

5. This step varies depending upon the type of ignition system:

– If testing a Standard system, select the Firing Order.

– If testing an Other system, select the RPM Factor.

Scroll through the list of available choices using the up and down arrows below the 
displayed firing order or RPM factor.

6. This step also varies depending upon the type of ignition system:

– If testing a Standard or Direct system, choose between Coil and Plug for the 
Number 1 Trigger.

– If testing a waste Spark system, select the polarity of the firings using the +, –, and 
arrow icons.

7. Select Back to return to the Preferences dialog box, or select Exit to close the dialog box and 
return to the scope.



109

Scope Multimeter Operations

Data

The Data icon on the toolbar switches the trace details information at the base of the screen as 
previously in Trace Details on page 94.

Cursor Controls

The cursor controls include a Show Cursors check box plus a slide control and arrows for moving 
the cursor position left or right. Select Cursors from the toolbar to open the Cursors dialog box 
(Figure 8-27).

1— Cursor 1 controls

2— Cursor 2 controls

3— Show or Hide icon

4— Back icon
Figure 8-27 Cursor controls

Cursor 1, the top slider and arrows, is the left-hand cursor on the screen. Cursor 2, the lower set 
of controls, is the right-hand cursor on the screen. Drag the slider or select the arrows to position 
the cursors. Each tap of the stylus moves the cursor incrementally in the direction of the arrow.

• Select Show to display the cursors (the icon changes to Hide).

• Select Hide to conceal the cursors (the icon changes to Show).

• Select Back to close the dialog box.

Refresh Controls

Selecting the Refresh icon from the Scope Multimeter Toolbar clears the minimum and maximum 
digital values and updates the viewing screen.
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File Controls

Selecting File from the toolbar opens a dialog box with a menu of save options:

Figure 8-28 Sample file setup dialog box

• Save Configuration—saves the current setup values as a preset.

• Save Single Frame—saves the data currently on the screen only.

• Save All Frames—saves the current screen plus all the data stored in the buffer.

z To save a file or configuration:

1. Select File from the toolbar.

2. Select a save option from the dialog box.

The Save As dialog box and the virtual keyboard open.

3. Use the keyboard to name the file to be saved, then either select the Save icon or select 
return on the keyboard.

Figure 8-29 

A configuration description dialog box opens.

NOTE:
i The description entered here is what displays in the information panel of the Data Manager.

4. Use the keyboard to enter a description of the file to be saved.

5. Select the OK icon or select return on the keyboard.

6. Select OK to close the file setup dialog box.

Once a configuration is saved, it becomes available as a preset. Files are saved to the Scope 
Multimeter Data Folder and can be retrieved through the Data Manager.

Print Controls

Selecting Print from the toolbar opens a standard Windows Print dialog box set up to print the 
current screen. A printer must be connected and setup on the diagnostic tool. If not, the “Add 
Printer Wizard” opens and guides you through the procedure. Select from the menus as needed.
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After using the Scanner function, Guided Component Test, and Scope Multimeter to diagnose and 
locate the source of problem, select Information on the Home screen to link to resources that help 
you fix the problem and get the vehicle back in service (Figure 9-1).

Figure 9-1 Sample Home screen  Information icon

A built in repair information database is available. Simply select the Information toolbar icon to 
open the program. A brief description of what type of information is available and how to navigate 
through the data follows below.

9.1   Vehicle Identification
What happens when theInformation icon is selected from the Home screen depends upon 
whether or not a test vehicle has been identified:

• With no active vehicle, the first in a series of vehicle identification screens that allow you to 
select the year, make, model, and other pertinent information for the test vehicle opens.

• With an active vehicle, theInformation main menu, which allows you top select different types 
of tests, opens (Figure 9-2).

Figure 9-2 Sample information main menu
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The Information main menu options are detailed in the table below:

NOTE:
i Anytime a Category icon appears in the upper toolbar portion of the screen while navigating 

through Information, selecting it returns you to the Information Menu (Figure 9-2).

Table 9-1 Information icon descriptions

Name Icon Description

Diagnostic Trouble 
Codes

Provides information on retrieving, diagnosing, and 
repairing diagnostic trouble code (DTC) problems. 
See “Diagnostic Trouble Codes” on page 113.

Engine Management 
Component Testing

Provides information on performing tests on engine 
management components. See “Engine 
Management Component Testing” on page 115.

Engine Management 
Pin Data

Provides connector diagrams and pin assignment 
information for engine management systems. See 
“Engine Management Pin Data” on page 118.

Component 
Locations

Provides graphics and text for locating various 
vehicle components. See “Component Locations” on 
page 119.

Wiring Diagrams
Provides instant access to a wiring diagram for the 
test vehicle. See “Wiring Diagrams” on page 121.
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9.2   Diagnostic Trouble Codes
Information for locating, diagnosing, and repairing diagnostic trouble code (DTC) problems is 
located here. Information is specific to the identified vehicle.

z To access DTC information:

1. Double tap the Diagnostic Trouble Codes icon.

A Data Category list displays (Figure 9-3).

Figure 9-3 Sample DTC category list

The number of categories available varies by make, model, and year. Select Cancel at the 
bottom of the list to return to the previous screen.

2. Select a category from the list 

NOTE:
i Additional information about the test vehicle is needed to ensure the correct information displays 

in some instances. If so, a window with a list of optional equipment opens when a category is 
selected. Highlight all of the correct options installed on the test vehicle, then select the Accept 
icon to continue.

The Diagnostic Trouble Codes screen opens.

9.2.1  Diagnostic Trouble Codes Screen

The DTC screen is divided into two main fields; the selection field on the left hand side and the 
information field on the right hand side. The selection field, which determines what information is 
shown in the information field, typically offers the following choices:

• Data Link Connector—this is the default selection that is active when diagnostic trouble 
codes is selected. The location of the data link connector (DLC) is shown in a graphic below 
the selection field.

• General Information—provides information such as common terminology, general test 
conditions, and standard fault descriptions.

• Accessing and Erasing—provides information on retrieving and clearing DTCs from the 
electronic control module (ECM).

• Trouble Code Identification—provides a definition and probable cause for DTCs.
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NOTE:
i There may be more than one Trouble Code Identification selection available, as the information is 

broken down into subcategories when there is a large amount of data or there are different types 
of codes available.

A search feature, available for all of the trouble code identification selections, is available to help 
you quickly find the code information you need.

9.2.2  Printing Diagnostic Trouble Code Information

All or part of the diagnostic trouble code information can be sent to a printer.

z To print diagnostic trouble code information:

1. Select the Print icon on the toolbar, see “Toolbar” on page 121 for details.

The Print Options window opens (Figure 9-4).

Figure 9-4 Sample Print Options window

2. Select the check boxes for the options to be printed.

3. Select OK to send the selected information to a printer, select Cancel to close the Print 
Options window without printing.

Select the Information - Vehicle ID icon in the upper-left portion of the screen at any time to end 
the current session and return to the vehicle identification screen.
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9.3   Engine Management Component Testing
Procedures for diagnosing, evaluating, and testing engine management system components are 
found in this section. Information is specific to the identified vehicle.

z To access engine management component testing:

1. Double tap the Engine Management Component Testing icon.

A category list displays (Figure 9-3). The number of categories available varies by make, 
model, and year. Select Cancel at the bottom of the list to return to the previous screen.

Figure 9-5 Sample engine management component testing category list

2. Select a category from the list.

The selected category screen opens.

Although category availability varies by vehicle, typical choices include:

• Diagnostic Trouble Codes—this is the same information available from the Diagnostic 
Trouble Codes icon, see “Diagnostic Trouble Codes” on page 113 for details.

• Component Testing—provides detailed procedures and specifications for testing system 
components and performing service operations.

• Wiring Diagram—this is the same information available from the Wiring Diagrams icon, see 
“Wiring Diagrams” on page 121 for details.

• Engine Bay—this information is also available from the Component Locations icon, see 
“Component Locations” on page 119 for details.

• System Layout—provides a graphical description of the engine management system design.

• General Test Procedures—provides common test procedures and service guidelines that 
apply to all makes and models.

• Safety Precautions—lists safety precautions that must be adhered to protect yourself, 
bystanders, the vehicle and equipment from accidental injury or damage.
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9.3.1  Engine Management Component Testing Screen

There are three main screen fields for engine management component testing (Figure 9-6):

1— Toolbar—located at the top of the screen, the toolbar allows you to quickly navigate 
between different functions and operations. See “Toolbar” on page 116.

2— Component Test Menu—located on the left-hand side of the screen, the menu shows 
what information is available and also selects what displays in the information field. See 
“Component Test Menu” on page 117.

3— Component Test Information—located on the left-hand side of the screen, displays an 
article that provides procedures for testing system components. See “Component Test 
Information” on page 117.

Figure 9-6 Sample component testing screen

Toolbar

Toolbar icons allow you to quickly move between operations and functions. The number of icons 
that are active depend upon what information is currently being displayed. An inactive icon is 
indicated by an “X” in the upper-left corner of the icon. Icon operation is described in the table 
below.

Table 9-2  Information icon descriptions (part 1 of 2)

Name Icon Description

Help Opens a help file that details tool operations.

Print
Opens a print dialog box that allows you to add 
customer information to the displayed article and 
send it to a printer.

Previous Illustration
Returns to show the previous illustration in the 
displayed article.
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Component Test Menu

The component test menu on the left side of the screen lists what articles are available in the 
upper portion of the field and displays illustrations for the selected article in the lower portion of the 
field. Selecting a menu item loads the related article into the right-hand field of the screen, and 
also opens a submenu below the original menu item.

Selecting a submenu item with the stylus advances the right-hand field to that point in the article. 
Selecting an expanded main menu item closes the submenu.

Component Test Information

Articles that display on the right side of the component test screen contain detailed test 
procedures, specifications, and other resource information used to make repairs. Illustrations 
related to the article are shown in the lower portion of the menu field. A scroll bar appears along 
the right margin of the field for lengthy article that do not fit on a single screen. Selecting an item 
from the submenu takes you directly to that point of the article.

Next Illustration
Advances to show the next illustration in the 
displayed article.

Wiring Diagram

Opens a wiring diagram for the test vehicle. This is 
the same diagram available from the Wiring 
Diagrams module, see “Wiring Diagrams” on 
page 121 for details.

Component Locator

Opens an engine bay component location illustration. 
This is the same illustration available from the 
Component Locations module, see “Component 
Locations” on page 119 for details.

Zoom Illustration
Opens a larger (full-screen) version of the illustration 
currently shown in the menu panel. Select anywhere 
on the illustration to return to the original screen.

Diagnostic Trouble Codes
Opens the Diagnostic Trouble Codes module, see 
“Diagnostic Trouble Codes” on page 113 for details.

Color Code Key
Opens a key to wiring diagram colour coding in a 
separate window. Select the “X” in the upper-right 
corner of the window to close it.

Category List
Opens the Engine Management Component Testing 
category list. This is the same list that displays when 
you first enter component testing.

Table 9-2  Information icon descriptions (part 2 of 2)

Name Icon Description
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9.4   Engine Management Pin Data
An electronic control module (ECM) connector diagram with pin assignments and test conditions 
are contained in this section. Double tap the Engine Management Pin Data icon to view the 
information (Figure 9-7).

1— View Tabs

2— Information Tabs

3— Component Selection
Figure 9-7 Sample ECM Pin Data screen

A table in the lower portion of the screen displays the available pin data. Several shortcuts are 
available from the table:

• If the name of the component in the Component/Circuit Description column is underlined, 
selecting the name with the stylus opens the component testing article for that item. See 
“Engine Management Component Testing” on page 115 for additional information.

• If a number appears in the Waveform column, a “known good” sample waveform is available 
for viewing. Select the number with the stylus and the waveform opens in a separate window. 
Select anywhere in the waveform window to close it.

9.4.1  View Tabs

The View Tabs determine which perspective of the ECM connector diagram displays. Two choices 
are available:

• Terminal Side—shows the connector as if it were disconnected from the ECM and you are 
looking into the face (open terminal side) of the connector.

• Wire Side—shows the connector as if it were connected to the ECM and you are looking at the 
wiring harness side of the connector. Commonly referred to as the “backprobing” view.

Use your finger or the stylus to select a view tab.
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9.4.2  Information Tabs

The Information Tabs determine how the ECM connector pin information displays. There are three 
information options:

• By Component—only the data for the selected component is shown in the table. Component 
selections are listed by name only in alphabetical order, there are no pin numbers on the list.

• By Pin Number—only the data for the selected pin is shown in the table. Component 
selections are listed by pin number only in numerically ascending order, there are no 
component descriptions on the list.

• All Information—all of the available pin data displays in the table sorted alphabetically by 
component name. A scroll bar at the right of the table is used to navigate through the data.

Use your finger or the stylus to select an information tab.

9.4.3  Component Selection

This field, which only displays when the By Component or By Pin Number tab is selected, is used 
to select what data displays in the table.

z To use component selection:

1. Select anywhere in the Component Selection field with the stylus.

The menu, sorted by component or pin as determined by the Information Tab selected, opens.

2. Select a menu item with the stylus.

The menu closes and the data for the selected item is now shown in the table. On the 
connector diagram, the pin for the selected item appears in red.

9.5   Component Locations
This section contains graphic depictions and textual references as to where specific components 
are located on the test vehicle. Selecting the Component Locations icon on the home page 
opens a data category menu.

Figure 9-8 Sample Component Locations category menu

The categories vary, but typically include:
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• Engine Management—provides engine control system component location information.

• Antilock Brake Systems—provides ABS component location information.

• Fuse Boxes/Relay Plates—provides power distribution component location information.

• General Components—provides major component location information for the entire vehicle.

• Airbags—provides supplemental restraint system component location information.

• Cancel—returns the display to the home page.

Component location screens vary somewhat by category, but all of them display the selected 
diagram in the lower portion of the screen (Figure 9-9).

1— Toolbar

2— Tabs

3— Scroll Bar

4— Component Selection Menu

5— Location Diagram
Figure 9-9 Sample fuse box/relay plate screen

A toolbar, located above the diagram, offers shortcuts to certain operations. Toolbar icon 
operations are the same as for Engine management Component Testing, see “Toolbar” on 
page 116 for descriptions. which toolbar icons display varies by category.

A component selection menu appears between the toolbar and the main screen on some 
diagrams. Select the listed item to open the menu and use the stylus to make selections. The 
menu collapses once an item is selected and a red highlight marks the location of the selected 
item on the diagram.

When viewing Fuse Boxes/Relay Plates diagrams a series of tabs located underneath the toolbar 
determines which fuse box or relay plate is displayed. A scroll bar moves the tabs left and right if 
there are more tabs than what will fit on a single screen.
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9.6   Wiring Diagrams
This home page selection contains system wiring diagrams for the identified test vehicle, the 
number of diagrams available varies by year and model. Selecting the Wiring Diagrams icon 
opens a data category menu. Select a menu item with the stylus to open the wiring diagram. A 
typical wiring diagram screen is shown in Figure 9-10.

1— Toolbar

2— Component Selection Menu

3— Full-width Window

4— Magnified Window
Figure 9-10 Sample wiring diagram screen

9.6.1  Toolbar

Most of the toolbar icon are the same as for Engine management Component Testing, see 
“Toolbar” on page 116 for descriptions. However, there are some icons that only appear on wiring 
diagrams. These are explained in the table below.

Table 9-3 Information icon descriptions

Name Icon Description

ECM Harness Connector
Opens an ECM harness connector diagram in a 
separate window. Only the connector displays, pin 
data in not shown.
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9.6.2  Component Selection Menu

The Component Selection menu is used to locate a particular item on the wiring diagram. Select 
the listed item to open the menu and use the stylus to make selections. The menu collapses once 
an item is selected and a red highlight marks the location of the selected item on the full-width 
diagram shown on the left-side of the screen.

9.6.3  Full-width Window

The window in the right-hand panel of the main screen provides a reduced (full-width) view of the 
wiring diagram. A scroll bar to the right of the window moves the diagram up and down on the 
screen. The full-width diagram is a navigational aid for locating elements on the magnified 
diagram in the right hand window. Use the full-width diagram as follows:

• Select any portion of the full-width diagram with the stylus and that area of the wiring diagram 
displays in the magnified window.

• Selecting a component on the full-width diagram with the stylus highlights that component in 
red, displays its name in the component selection menu window, and displays that portion of 
the wiring diagram in the magnified window.

• Move the full-width diagram scroll bar and the magnified window scrolls as well.

9.6.4  Magnified Window

The window in the right-hand panel of the main screen provides a magnified view of a small 
portion of the wiring diagram. Use this window to read details on the wiring diagram. Select the 
Full Size icon on the toolbar to view the complete diagram.

Full Size
Expands the wiring diagram to full-page size, scroll 
bars appear for moving up and down and left and 
right through the diagram.

Fit to Window
Cancels the full-size diagram and return to the 
split-screen display.

Table 9-3 Information icon descriptions

Name Icon Description
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Vehicle History allows you to manage and retrieve vehicle records, for vehicles that have been 
scanned or identified previously. You can also activate a vehicle, so there is no need to go through 
the complete vehicle identification sequence when performing a retest after repairs have been 
made.

10.1   Screen Layout
There are two main parts to the vehicle records list screen:

1— Vehicle History Toolbar

2— Main Body (Records List)
Figure 10-1 Vehicle records list screen

10.1.1 Vehicle History Main Body (Records List)

The main body of the screen lists all of the available vehicle records. By default, records are 
shown in the order in which they are entered. However, you can resort them by any of the 
categories shown as column headings. You can also resize the individual columns.

z To sort records:

1. Select a category heading.

The listed items resort according to the selected category. A triangle appears alongside the 
name of the column that was used for the sort.

2. Select the triangle in the heading to reverse the sort order.

1

2
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z To resize a column:

1. Select the line separating two columns.

A line with arrowheads appears to show the column is ready for resizing.

2. Drag the line left or right to increase or decrease the column width.

10.1.2 Vehicle History Toolbar

The table below gives brief descriptions of the control icons on the toolbar:

Activate

Use this icon to activate a vehicle for use in other functions (e.g. Scanner, Guided Component 
Tests, etc.). The diagnostic tool will use the identification information stored in the vehicle history 
record to load the correct vehicle database, so there is no need to identify the test vehicle again.

z To activate a vehicle:

1. Locate and highlight the desired vehicle record on the records list screen.

2. Select Activate from the toolbar.

The Activate icon is removed from the toolbar once a vehicle has been selected.

3. Select the Home icon.

The Home screen displays with the activated vehicle shown on the toolbar.

4. Select any Function icon on the Home screen to begin testing.

Table 10-1 Toolbar icons

Name Icon Description

Back
Returns to the previously viewed 
screen.

Activate
Activates the selected vehicle, for use 
with other functions (e.g. Scanner, 
Guided Component Tests, etc).

View Opens the selected vehicle record.

Delete
Deletes the selected vehicle record from 
memory.

Manage
Opens the vehicle Manage Records 
screen.

Search
Opens a window that allows you to 
locate a particular vehicle record.

Show All
Available only after a search, use to 
return to a complete vehicle records list.

Settings
Opens a window that allows you to 
configure which fields display on main 
records list screen.
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View

Select View to open, edit, add notes, and print a vehicle record.

z To open and/or modify a vehicle record:

1. Highlight the desired vehicle record from the vehicle records list screen, then double click it, 
or select View from the toolbar.

The record for the selected vehicle opens (Figure 10-2).

The vehicle record includes vehicle ID information, DTC data, and other data entry fields for 
owner and vehicle information, and technician notes. Depending on the vehicle information 
that was used to identify the vehicle, some data may be already entered. The example below 
shows, DTC scan results from the last code scan performed, and an attachment “Vehicle 
System Report Data” PDF file.

Vehicle ID information is captured slightly different across the different functions
(e.g. Scanner, Guided Component Tests, etc.), as some functions may capture more/less 
information during the process. Selecting the Other Vehicle ID button, opens a listing of the 
captured vehicle ID fields from each applicable function. If more than one function was used 
to ID the vehicle, you are given the option to use that vehicle ID set as the default ID for the 
vehicle record. 

Figure 10-2 Sample vehicle record

NOTE:
i The virtual keyboard automatically opens the first time you select within one of the data fields.

2. Use the virtual keyboard to enter information in the data fields. The data is automatically 
saved.

3. Select Back to return to the vehicle records list screen.

Delete

Select Delete to remove unwanted items from the vehicle records list. Highlight the record to 
remove, then select Delete.

Vehicle System Report Data_6_20_16.pdf



126

Vehicle History Operations Screen Layout

Manage

Select Manage to quickly remove individual records, or all the vehicle records from the vehicle 
records list. Highlight the record to remove, then select Delete, or use the Select All or Deselect 
All options to remove all records (Figure 10-3).

Figure 10-3 

Search and Show All

Selecting Search opens a dialog box that allows you to search vehicle records by category. You 
can search for data in the following categories:

– Year

– Make

– Model

– Color

– Customer

– License

– State

– Technician

z To search:

1. Select Search from the toolbar.

2. Enter the search criteria in the text field (Figure 10-4).
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Figure 10-4 Sample Search dialog box

3. Select Search twice. The first tap closes the keyboard, the second tap starts the search.

The display returns to the vehicle records list screen with only the records found in the search 
criteria showing.

4. Select Show All on the toolbar to restore the complete vehicle records list.

Settings

Use Settings to determine which categories display on the vehicle records list screen. Selecting 
the Settings icon opens a vehicle history category display menu.

z To change Settings:

1. Select Settings to open the menu.

Figure 10-5 Sample Settings dialog box.
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2. Select or deselect the desired categories:

– Highlighted items - do not display

– Non-highlighted items - display

3. Select OK on the toolbar to accept the changes, and return to the previous screen.
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The Data Manager is used to store, sort, and review saved files. Most operations are controlled 
through the toolbar. 

11.1   Screen Layout
Select Data Manager on the Module toolbar to open the file system. Use the toolbar at the top of 
the screen to navigate through the data. The folders panel below the toolbar displays the contents 
of the Windows My Documents > ShopStream folder, which is the Data Manager main screen. The 
information panel on the lower-left portion of the screen shows a summary of the saved file when 
available, and the preview panel on the lower right displays an image if the selected file is a 
graphic.

1— Data Manager Toolbar

2— Folders Panel

3— Preview Panel

4— Information Panel
Figure 11-1 Sample Data Manager main screen

The main screen includes folders for saved files from the various modules:

• Camera Folder—contains photographs taken with the built-in camera. See Image Viewer on 
page 153.

• CTM Data Folder—contains files saved while working in the Guided Component Test 
module.See Scope Viewer on page 152.

• Sample Files—contains an assortment of example saved data files.

• Scanner Data Folder—contains files saved while working in the Scanner function. See 
Scanner DataViewer Operation on page 142.

1

2

3

4
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• Scope Multimeter Data Folder—contains files saved while working with the Scope Multimeter. 
See Scope Viewer on page 152.

• Screenshots—contains images saved by pressing the Shortcut (S) button. See Image Viewer 
on page 153.

11.2   Navigation 
Use the toolbar icons as shown in the table below to navigate through the Data Manager:

Table 11-1 Data Manager toolbar icons

Name Icon Description

My Data Returns to the Data Manager main screen.

Up
Moves the items displayed in the folders 
panel up one level in the file structure.

Open Opens the highlighted folder or file.

New Creates a new folder.

Delete
Moves the highlighted file or folder to the 
recycling bin.

Rename
Opens a dialog box and the virtual keyboard 
for renaming the selected file or folder.

Save
The Save function is not implemented at this 
time.

Properties
Opens a dialog box and the virtual keyboard 
for renaming the selected file or folder.

Shortcut
Creates a shortcut to the highlighted item on 
the Data Manager main screen. See Shortcut 
on page 135 for information.

Email
Send data files as attachments, using Email.  
See Email on page 136 for information.

More (optional) Opens hidden menu options
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11.3   Operations
Data Manager operations based on toolbar selections are explained in the following sections.

11.3.1 My Data

The My Data icon is a shortcut that quickly returns you to the main Data Manager screen. Select 
the icon at any time to instantly return. Note the location of the page being viewed is shown near 
the top of the screen just above the toolbar.

11.3.2 Up

This icon reflects the items shown in the folders panel of the screen up in the file structure one 
level at a time. For example; one tap of the Up icon when viewing the contents of the Scanner Data 
Folder returns you to the main screen. A second tap would display the contents of the “My 
Documents” folder.

11.3.3 Open

The Open icon is only active (displays in color) when an item in the folders panel is highlighted.

z To open a folder:

1. Highlight the file to open in the folders panel.

2. Select the Open icon to load the highlighted file.

Figure 11-2 Sample open folder showing information
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The screen advances and the contents of the open folder are shown in the folders panel. 
Highlight an item in the folders panel and the information or preview displays, if available, in 
the lower portion of the screen (Figure 11-2).

3. To exit the current folder:

– Select My Data on the toolbar to return to the main Data Manager screen.

– Select Up on the toolbar to return to the previous page.

11.3.4 New

The New icon allows you to create a new folder. This option is only available when the icon 
displays in color.

z To create a new folder:

1. Select the New icon on the toolbar.

The New Folder Name dialog box opens (Figure 11-3).

2. Select the entry field on the dialog box to open the virtual keyboard.

3. Type a name for the new folder using the virtual keyboard.

4. Select the OK icon to create the new folder and return to the previous page. The Cancel icon 
returns you to the previous page without creating a new folder.

Figure 11-3 Sample New Folder name dialog box
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11.3.5 Delete

The Delete icon moves folders or items within folders to the Recycling bin. A confirmation displays 
when a file is selected for deletion. Select Yes to delete the file or Cancel to exit.

z To delete an item:

1. Select to highlight the item or folder to be deleted.

2. Select the Delete icon on the toolbar.

A confirmation message displays (Figure 11-4).

Figure 11-4 Sample delete confirmation message

3. Select OK to delete the selected item and return to the previous page. The Cancel icon 
returns you to the previous page without deleting the selected item.
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11.3.6 Rename

The Rename icon allows you to change the name of a folder or items within a folder. 

z To rename an item:

1. Highlight the item or folder to be renamed.

2. Select the Rename icon on the toolbar.

The New Name dialog box opens (Figure 11-3).

Figure 11-5 Sample new name dialog box

3. Select the entry field on the dialog box to open the virtual keyboard.

4. Type the new name into the entry field using the virtual keyboard.

5. Select the OK icon to change the name and return to the previous page. The Cancel icon 
returns you to the previous page without changing the name.
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11.3.7 Properties

The Properties icon function allows you to change the name and assign identifying attributes to 
saved Scope Multimeter files. Operation is similar to renaming a file as discussed above, except 
there are additional fields for entering descriptive information.

z To assign properties to an item:

1. Highlight the item or folder.

2. Select the Properties icon on the toolbar.

The Properties dialog box and the virtual keyboard open (Figure 11-3).

Figure 11-6 Sample Properties dialog box without the virtual keyboard

3. Type a new name into the field using the virtual keyboard if you want to rename the file.

4. Use either the virtual keyboard or the dropdown menus to fill in the Year, Make, Component, 
and Condition fields.

5. Select the OK icon to change the name and return to the previous page. The Cancel icon 
returns you to the previous page without changing the name.

11.3.8 Shortcut

Selecting the Shortcut icon creates a shortcut to the highlighted item on the Data Manager main 
screen. A confirmation message “A shortcut has been created in the default folder for 
***sample file name***” displays when this option is selected.
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11.3.9 Email

Selecting the Email icon from the Data Manager toolbar allows you to send a saved data or image 
file as an attachment using e-mail. To use this feature, you must install an e-mail client, and then 
either link your existing e-mail address to the client, or create a new address. The following 
instructions are intended as a guide only.  

z To attach a file from a Data Manager folder to an e-mail:

NOTE:
i The Email feature uses your system default email client. Refer to Windows Help for instructions on 

setting your default e-mail client. For an example on how to setup an e-mail client, see E-mail 
client installation and setup (Example): on page 137. 

NOTE:
i This diagnostic tool is equipped with Microsoft Outlook Express e-mail client. To use this client, 

open the Microsoft Outlook Express program and run the New Connection Wizard following the 
screen prompts, and then either create an e-mail account or use your existing account to complete 
the setup. You may be required to enter setup information (e.g. incoming and outgoing server 
names, types, and port values), contact your ISP and/or e-mail provider for additional information. 

1. From the Data Manager main screen, select a file from within one of the folders (e.g. Camera, 
Scanner Data, Scope Multimeter, etc). In this example (Figure 11-7). a Scope data file was 
chosen.

2. With the file highlighted, select Email from the toolbar.

Figure 11-7 

3. A new e-mail message window displays with the selected file attached (Figure 11-8).

NOTE:
i If the e-mail message window does not appear, check the Windows taskbar.
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Figure 11-8 

4. Enter the e-mail address of the recipient, and any other information needed.

5. Select the Send icon to send the e-mail.

NOTE:
i You must have an Internet connection to send e-mail.

z E-mail client installation and setup (Example):

The following instructions are intended as a guide only, as e-mail client setup procedures vary.

1. Download an email client (e.g. Mozilla Thunderbird) (Figure 11-9).

Figure 11-9 

attachment
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2. Install the software following the screen prompts (Figure 11-10).

Figure 11-10 

3. Continue through the setup. If available choose “set as my default mail application” 
(Figure 11-11).

Figure 11-11 
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4. Choose to use your existing email address, or create a new email address with the email client 
(Figure 11-12).

Figure 11-12 

5. Enter your e-mail information as required (Figure 11-13).

NOTE:
i E-mail client configuration settings should automatically be set during installation. If problems 

arise with the setup and manual configuration is needed, refer to the e-mail client help information 
and the Windows help information. 

Figure 11-13 
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6. If your existing email provider login screen displays, enter your email address and password 
to allow the client to continue the setup with your provider (Figure 11-14). 

Figure 11-14 

7. Follow the screen prompts to allow the client to link to your email address.

8. Once the client has successfully linked to your address, you can begin using the new e-mail 
client software on the diagnostic tool (Figure 11-15). 

Figure 11-15 
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11.4   Viewing Saved Files 
As mentioned in the beginning of this section, the data and image files in the Data Manager folders 
are also accessible from the Windows My Documents > ShopStream folder. You may access, 
copy or move the files you save in the ShopStream Diagnostic Suite program from the folder at 
anytime. 

The files may also be transfered to portable USB drives and then transfered to your PC. All copy, 
move and save functions are accomplished using standard Windows operations. 

Camera images and screenshots are saved as JPEG files and are viewable on most PCs. Data 
files are saved using propriety file extensions and are not viewable on a PC without the use of 
ShopStream Connect. See ShopStream Connect™ on page 141 for additional information.

11.4.1 ShopStream Connect™
Data files saved on your diagnostic tool are designed and intended to be reviewed using the Data 
Manager functions as described earlier. An alternative method can be used to review select data 
files on a PC using ShopStream Connect. 

ShopStream Connect is PC-based program that allows you to manage, view and print data files 
using a PC. ShopStream Connect is a free program available for download from our website. See 
the contact information at the front of this manual for website information.

11.5   Saved File Structure
The Diagnostic Suite automatically creates folders to manage saved files. Whenever 60 files are 
saved into any of the Data Manager menu option folders, a new folder is created. Folders may 
contain files for a day, week, month, or a year. An older folder, when available, goes to the next 
higher level in the files structure menu (Figure 11-16).

Figure 11-16 Sample saved file folder structure
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11.6   Scanner DataViewer Operation
The Scanner DataViewer allows you to review saved scanner data files (Figure 11-17). To open 
saved Scanner data files, select the Scanner Data Folder menu option from the Data Manager 
main menu.

Scanner DataViewer - Opens .pids, .scm, .scs, .scp and .spm file extensions

1— Menu bar

2— Display toolbar

3— Graph display

4— Properties icon

5— Vertical Scroll bar

6— Zoom controls

7— Slider bar

8— Navigation toolbar

9— Parameter text list

10—Parameter configuration tabs
Figure 11-17 Scanner Data Viewer
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11.6.1 Menu Bar

The menu bar at the top of the screen contains the File, View, Tools, and Help menus.

File Menu

The File menu offers the following selections:

• Load—locate and open data files, launches a navigation window

• Print—print selected pids

• Print Preview—preview pids before printing

• Exit—closes Scanner DataViewer

When Print or Print Preview is selected, a dialog box opens and allows you to define the printed 
output. Print settings include, print as graphs or text, which pids to include, number of pids per 
page, display colors, and the text font (Figure 11-18).

Figure 11-18 Pids print settings

z To print:

1. Select the desired pids. A checked box indicates the pid will be printed. Select again to 
deselect the pid.

2. Select Change to modify the font, this opens a standard Windows font dialog box.

a. Modify the font as desired.

b. Select OK to close the font dialog box.

3. Once all selections are made, select OK.

A print dialog box opens.

4. Select OK.

a. If Print was selected, the file is sent to the printer.

b. If Print Preview was selected, a preview window opens. Select the printer icon 
(Figure 11-19) to send the file to the printer.
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Figure 11-19 Print preview window (text list and graphs examples)

View Menu

The View menu allows you to change how data is displayed on the screen (Figure 11-20).

Figure 11-20 Scanner DataViewer View menu

Select from the following menu options:

• Text Only—shows all parameters and their values as text only

• Graphs Only—shows all parameters as graphs only

• Text and Graphs—shows all parameters and their values as text in the left panel of the 
screen, and shows them as graphs in the right panel of the screen
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Tools Menu

The Tools menu opens the Properties dialog box.

The Properties dialog box has two sections (Figure 11-21); Shared Graph Properties and 
Individual Properties. Shared Graph Properties apply to all graphs and Individual Properties apply 
to the selected graph only.

Figure 11-21 Properties dialog box

Properties dialog box selections include:

• Grid Lines—when selected, a line displays at each major division of the graphs.

• Display Item—use to view the display color of the listed items. Highlight an item and the 
current color appears in the Color box.

• Change—use to change the color of the highlighted item, select to open a color palate.

• Sweep—use to adjust the number of data frames that appear on the screen (zoom in or out), 
highlight and type in the desired number.

• Reset Colors—use to restore the default color settings.

• Data Item—use this pulldown menu to select individual graphs for modification.

• Auto Scale—minimum and maximum (Y axis) values automatically adjust to the signal when 
the box is checked, uncheck the box if you want to custom set the values.

• Y Axis Range—use to type desired minimum (from) and maximum (to) values in the selection 
boxes. This field is only active when Auto Scale is deselected.

• OK—applies the changes and closes the properties dialog box.

• Cancel—closes the properties dialog box without making changes.

• Apply—applies the changes and leaves the properties dialog box open.

NOTE:
i The Properties icon on each graph also opens the Properties dialog box (Figure 11-17).
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Help Menu

The Help menu provides Scanner Viewer software version information.

11.6.2 Display Toolbar

The Display toolbar provides the following controls (Figure 11-22).

• Exit—closes Scanner DataViewer.

• Hide PID List—toggles display between parameter text and graph views.

• Display Views (1 to 16)—determines how many graphs display at a time.

• Scale—switches the scale values shown to the left of the graph off and on.

• Sweep—switches the sweep values shown below the graph off and on.

Figure 11-22 Display toolbar
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11.6.3 Navigation Tools

Playback Controls

The playback controls allow you to navigate through saved data (Figure 11-23).

1— Skip Back—Allows backward movement in multiple steps.

2— Step Back—Allows backward movement in singular steps.

3— Play—Select to play.

4— Step Forward—Allows forward movement in singular steps.

5— Skip Forward—Allows forward movement in multiple steps.

6— Pause—Select to pause playback.
Figure 11-23 Playback controls

Zoom Controls

The zoom controls allow you to incrementally increase or decrease the screen magnification 
(Figure 11-24).

Figure 11-24 Zoom controls
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Slider / Scroll Bars and Cursor

Use the slider bar to quickly navigate through the data (Figure 11-25). During playback the 
number displayed on the left side of the slider bar indicates the current position of the cursor in the 
data file. The cursor can be repositioned during playback or when paused, by selecting and 
dragging.

Use the scroll bar (right side) to vertically scroll through the parameter list and graphs.

1— Cursor

2— Scroll bar

3— Slider bar
Figure 11-25 



149

Data Manager Operations Scanner DataViewer Operation

11.6.4 Customizing the Display

The parameter text list (left side) displays parameter names and current values.

The display can be customized by selecting and dragging parameters from the text list or graph 
display to a different location in the text list or in the graph display (Figure 11-26). The highlighted 
parameters in the text list indicate which parameters are displayed as graphs.

NOTE:
i The parameter text list is sortable by name and value. Select Name or Value at the top of the list 

to change the sorted view.

Figure 11-26 
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11.6.5 Customizing the Parameter List
1. The parameter configuration tabs allow you to choose between displaying all available 

parameters (Complete List), or only those from a (Custom List) (Figure 11-27).

z To customize the parameter list:

1. Select the Custom List tab (Figure 11-27).

2. Select Edit List in the custom window.

1— Edit List

2— Custom List tab
Figure 11-27 
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A list of available parameters displays (Figure 11-28).

3. Select the parameters to include in your custom list. Select All and Deselect All controls are 
also available to assist in the selection process.

Figure 11-28 Creating a custom parameter list

4. Select Save & Exit to close the window.

Only the parameters selected in your custom list are displayed.
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11.7   Scope Viewer
This section is intended as an introduction of the Scope Viewer, as many features are similar to the 
Scope module features. The Scope Viewer allows you to print and playback recorded trace 
signals captured on your diagnostic tool. When a scope file is selected, it opens and displays in 
the  Scope File Viewer.

The Scope Viewer allows you to print and playback recorded trace signals captured on your 
diagnostic tool. When a scope file is selected, it opens and displays in the  Scope File Viewer.

The Scope File Viewer is intended to be used to review scope and meter files originally captured 
on a diagnostic tool. Some features (control icons) of the Scope File Viewer may not be available 
“grayed out”. This is normal as those features are only applicable when viewing live data on a 
diagnostic tool.

The Scope File Viewer screen includes the following sections:

Figure 11-29 

1— Toolbar - contains control icons

2— Main Body - displays recorded trace results 

3— Profile Controls Window - displays profile control icons and trace display settings 

4— Playback Control Toolbar - contains playback and display controls 

2

1

3

4
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11.8   Image Viewer 
The Image Viewer allows you to open and view image files and screenshots. 

Figure 11-30 

1— Exit - closes the Image Viewer

2— Print - prints the image

3— Captured Screen Image

31 2
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Selecting Help from the Home screen opens this manual in a dedicated screen viewer. Navigate 
through the file either by gesture scrolling on the touch screen, or with the scroll bar along the right 
edge of the viewing screen. A left-to-right scroll bar appears at the bottom of the screen when 
magnification is increased.

All listings in the Contents and Index are active links. Select an entry with the stylus to go directly 
to that point of the document. Additional links within the text, shown in blue-colored type, also take 
you to the referenced section of the manual.

12.1   Using the Help Toolbar
A simple toolbar at the top of the screen is used to adjust screen magnification and to exit Help:

Table 12-1 Help toolbar icons

Name Icon Description

Back
Closes the help file and returns you to 
the previously viewed screen.

Zoom +
Incrementally increases the screen 
magnification.

Zoom –
Incrementally decreases the screen 
magnification.

Reset
Restores the default screen 
magnification.

Previous Page Moves back one page in the document.

Page Counter
Shows the current page over the total 
number of pages in the document.

Next Page
Moves forward one page in the 
document.

More
Opens a menu of the additional options 
(Hide TOC or Show TOC) shown 
below.

Hide TOC

Closes the contents and search column 
so the document fills the screen.

Show TOC

Opens the contents and search column 
if they have been hidden.

Exit
Closes the help file, and any other 
open modules, and returns you to the 
Home screen.
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Selecting System Settings from the Home screen opens a menu with two options:

• Paired Devices - Paired Devices allows you to check the status and pair wireless devices to 
the Diagnostic Tool.

• Shop Information - Shop Information allows you to create and edit a personalized header that 
is included on printed documents.

• Data Backup - Provides two options, backup and restore.

13.1   Paired Devices
The wireless Scan Module makes vehicle data readily available on the Diagnostic Tool while 
working anywhere on or around the vehicle. Before use, wireless units must be “paired” in order 
to create a communications network between them. Information about modules paired to the 
Diagnostic Tool can be found by selecting System Settings from the Home screen.

z To check the devices paired to your Diagnostic Tool:

1. Select System Settings > Paired Devices.

The paired devices screen opens (Figure 13-1).

The Paired Devices screen lists all of the devices paired to the Diagnostic Tool, and also indicates 
whether or not there is active communication occurring.

Figure 13-1 Typical Paired Devices screen
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The Hardware Status indicators in the lower-right corner of the Home screen provide a quick 
reference to wireless device operations. The background color of the status indicator icon 
represents the condition of the wireless connectivity to that device. Icon status is shown in the 
table below:

13.1.1 Pairing the Wireless Scan Module

For detailed information on the use and pairing of the Scan Module, see "Pairing The Scan 
Module‚" on page 55. 

Hardware 
Icon

Background 
Color Condition Action

Scan Module

Red Not Paired
Pair the Scan Module to the Diagnostic Tool. 
See "Pairing The Scan Module‚" on page 55 for 
instructions.

Grey
Paired, but Not 
Communicating

You may have moved out of range. Move the 
Diagnostic Tool closer to the Scan Module to 
reestablish communications. If connectivity is 
not restored, perform the "Recovery 
Procedure‚" on page 61.

Blue
Paired and 
Communicating

Hardware status is good and Bluetooth should 
be functional. Verify that the green Bluetooth 
LED on the front of the Scan Module is flashing. 
If there is no connectivity, perform the 
"Recovery Procedure‚" on page 61.

Green USB Cable Connected Indicates the USB cable is connected.

Gray
USB Cable Not 
Connected

Indicates the USB cable is not connected or 
connected but not allowing communication
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13.2   Shop Information
This option allows you to add personalized shop information that can be included on printed data 
files. Selecting opens a form that can be filled in using the virtual keyboard. Select OK when the 
form is complete and the information is saved.

z To add Shop Information:

1. From the Home screen select System Settings.

2. From the System Settings menu select Shop Information.

The Shop Information dialog box opens (Figure 13-2).

Figure 13-2 Sample Shop Information dialog box

3. Select within any of the information fields and the virtual keyboard opens.

4. Use the virtual keyboard to fill in the Shop Information form.

As an alternative, you can connect a USB keyboard to a USB jack on the Diagnostic Tool and 
use it to enter information into the form.

5. Close the virtual keyboard and review the information once all the fields have been filled in.

6. Select OK from the toolbar to save the Shop Information, or Cancel to close the Shop 
Information dialog box without saving.

The Shop Information screen closes and the screen returns to the System Settings menu.
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13.3   Data Backup
Selecting Data Backup from the Systems Settings main menu provides two options, backup and 
restore. 

13.3.1 Backup

The Backup option allows you to back up your saved data to a file on the internal hard drive, or to 
an external drive (e.g. USB flash drive). This option can be used as general maintenance to 
ensure you have a safe backup of your saved data, or if a issue occurs where a system restore is 
necessary and you need to retain your saved data. The following types of data are backed up: 

• ShopStream Data (saved movie/data files)

• Lab Scope Settings (presets)

• Vehicle History Records and Favorites

z To Backup Information:

1. From the Home screen select System Settings.

2. From the System Settings main menu select Data Backup > Backup.

The destination drive dialog box opens (Figure 13-3).

3. Select a drive destination.

NOTE:
i Drive designations (e.g. E:/, F:/ etc.), are only visible when external drives are connected to the 

diagnostic tool. 

Figure 13-3 

A progress screen is displayed as the backup file is saved to the root of the drive selected with a 
file extension of .sna. Then a confirmation screen is displayed.

4. Select OK to complete the procedure.
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13.3.2 Restore

The Restore option is used to restore your backed up data, in the event that the data is lost or if a 
system restore (recovery) has been performed. 

This function is only applicable when a backup file has been previously saved (file extension .sna). 
See "Backup‚" on page 158 for additional information. 

z To perform a data Restore:

1. From the Home screen select System Settings.

2. From the System Settings main menu select Data Backup > Restore.

The restore file confirmation dialog box opens (Figure 13-4).

3. Select Continue.

Figure 13-4 

The Windows restore backup file path dialog box opens.

4. Select the backup file (file extension .sna) from your backup file location.

5. Select Open to restore the backup file.

Once the file has been restored a confirmation message is displayed.

6. Select OK, then close and restart the Diagnostic application.
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Designed to help you improve diagnostic accuracy and reduce repair time, SureTrack is a 
comprehensive source of expert knowledge for professional technicians, combining diagnostic 
experience and detailed parts replacement records.

SureTrack offers this exclusive list of features:

• Verified parts replacement records shows which parts are most frequently replaced to 
successfully complete repairs for symptoms, codes and vehicles similar to the one in your 
shop

• Real Fixes harvested from millions of successful repair orders

• Up-to-the-minute intelligence 

NOTE:
i To access SureTrack, you must have the current software update installed, the Wi-Fi radio turned 

on and connected to a wireless network.

14.1   SureTrack Access
SureTrack is included with current Diagnostic Tool system software. To use SureTrack you must 
have the current software upgrade installed on your Diagnostic Tool. 

As a reminder to keep your software current and retain your access to SureTrack, software 
upgrade reminder messages will display periodically when new software upgrades are available 
(Figure 14-1). To purchase software upgrades or join the software subscription program, see your 
Snap-on Representative.

Selecting OK will close the message box until the beginning of the next month when it will appear 
to remind you again. Selecting Snooze 1 Week will close the message box for approximately one 
week and then it will re-appear.

Figure 14-1 Software Upgrade Reminder Message
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14.1.1 SureTrack Status Messages

Depending on your software version and connection status the following messages may appear 
in the SureTrack status bar:

• SureTrack Content May Be Available! - indicates SureTrack content may be available, 
however you are not currently connected to the SureTrack database. This message may be 
caused by a Wi-Fi connection issue or if you do not have the current software upgrade 
installed. 

• Loading content from SureTrack - indicates SureTrack information is being updated from 
the SureTrack database.

• A new diagnostic software upgrade is available. See your sales representative for 
details - indicates your access to SureTrack will be expiring soon and you should contact your 
sales representative to purchase the current software upgrade.

• Your SureTrack access has expired. See your Snap-on representative to renew. - 
indicates your access to SureTrack has expired and you should contact your sales 
representative to purchase the current software upgrade.

• Verified parts replacement data not available. - indicates repair and/or diagnostic 
information is not available at this time for the identified vehicle.

• Network not available. - indicates that you have a connection problem with your wireless 
network.

14.2   Using SureTrack
SureTrack repair information can be accessed while reviewing DTCs in Scanner Mode, to provide 
you with diagnostic information specific to the DTC selected. Available DTCs are displayed in a list 
that includes the DTC, a brief description, and a Fix It! icon (Figure 14-3).

Figure 14-2 Typical - DTC List

Selecting the Fix It! icon displays the following SureTrack content, described this the following 
sections:

• Common Replaced Parts Graph

• Dashboard Feature Information
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14.2.1 Common Replaced Parts Graph

The Common Replaced Parts graph (Figure 14-3) shows the percentage of verified fixes (using 
the parts listed) derived from the total number of repairs by mileage. One example in the 
illustration below indicates that based on 37 repairs involving vehicles with up to 200k miles, 
approximately 16% of the repairs (spark plug replacement) occurred at 125k miles.

Figure 14-3 Typical - Common Replaced Parts Graph

1— Common Replaced Part Graph icon—toggles Common Replaced Parts graph display 
on/off.

2— Common Replaced Part Graph

14.2.2 Dashboard Feature Information

Dashboard Feature Information includes:

• Detailed DTC Information 

• Related Tips, Real Fixes and Repair Information

SureTrack can display detailed information about the current DTC describing code setting 
conditions, possible symptoms, system operation and possible solutions (Figure 14-4). In 
addition, other reference links may be provided such as schematics and illustrations. 

Figure 14-4 Typical - “Fix It!” DTC Information
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NOTE:
i The Fixed It! numbers shown (e.g. +28) in Figure 14-4 indicate the total number of repairs 

surveyed that replaced the #1 ignition coil to fix the vehicle.

Menu options are also provided for the following:

Related Tips—opens a list of tips that may include information that is related to the current DTC 
(Figure 14-5). 

Figure 14-5 Typical - Related Tips Screen

Real Fixes—opens a list of tips related to the current DTC that have been gathered from actual 
shop repair orders and presented in a Complaint, Cause, Correction format (Figure 14-6). 

Figure 14-6 Typical - Real Fixes Screen
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Repair Information—opens the Information function (Figure 14-8). The Information program is a 
built in repair information database. For additional information, see “Information” on page 111.

Figure 14-7 

Figure 14-8 Information Main Menu
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(SST)

The ShopStream Update Tool (SST) is a maintenance program that automatically keeps your 
diagnostic software up-to-date.

The following terms are used in this section and throughout this manual as described below:

• Software Upgrade - a new diagnostic software version. Software upgrades include new and 
enhanced coverage and features.

• Software Update - a service release “update” for a existing diagnostic software version

For clarity, throughout this document the term “software update(s)” will be used to collectively 
describe “software updates, upgrades and SST program updates” using the SST, except where 
noted.

The ShopStream Update Tool program downloads and installs:

• Diagnostic software upgrades

• Diagnostic software updates

• SST program updates

When connected to the Internet, the SST automatically checks for new software updates. This 
automatic check also occurs every time the diagnostic tool is turned on. If a software update is 
available, the SST will download it. 

The SST is a low priority program that only downloads software updates when unused bandwidth 
is available. If other programs are running that communicate over the Wi-Fi network, such as a 
browser or instant messaging, the download may be temporarily suspended. This allows you to 
continue normal diagnostic tool operation, without interruptions or loss of performance.

15.1   Basic Operation
The SST program is normally running in the Windows background and available from the 
Windows system tray. The program can be accessed as follows: 

• SST icon in the Windows system tray - opens the SST program menu

• SST program selection from the Windows “All Programs” or “Startup” menus - starts 
the SST program and adds the SST icon to the Windows system tray

NOTE:
i If necessary, select the expand arrow to see the SST icon in the system tray.
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Figure 15-1 SST Icon in system tray

Selecting the SST icon from the system tray provides the following menu choices: 

• Check for Updates - Allows you to manually check for software updates anytime. See 
Manual Software Download on page 167.

• Show Progress - allows you to check the status of an active download 

• Settings  - provides SST program options:

– Turn on/off automatic software installation. Applies only for SST program updates. The 
default setting is “on” (box checked).

– Set the hourly interval for the SST to check for software updates (choose number 2 to 
168). Applies to SST program updates, and diagnostic tool software 
upgrades/updates. The default interval is 4 hours. 

Figure 15-2 

• About - displays the SST program software version number 

• Exit - closes the SST program
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15.2   Manual Software Download
This section describes the basic procedures for manually downloading software updates and 
upgrades.

Normally, the SST will automatically detect and download software. If necessary, use the following 
procedure to manually check for and download software.

NOTE:
i It is recommend that you download software upgrades when not actively using the diagnostic tool. 

Download times will vary as they are dependent on the file size of the upgrade (some upgrades 
may exceed 3Gb) and your connection speed. It is suggested that you start the download at the 
end of your day and let it run overnight. It is also suggested that you ensure a download of this size 
is within the available data allowance of the Internet connection or data plan being used. For 
software upgrade installation instructions, see Installing Software Upgrades on page 171.

z To manually download software:

1. Select the SST icon in the system tray to open the menu (Figure 15-3).

Figure 15-3 ShopStream Update Tool icon and menu
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2. Select Check for Updates from the menu.

A series of message boxes will display as the SST searches for updates (Figure 15-4). 

Figure 15-4 Typical - Checking for Updates message

Once the search is complete, one of two results are expected:

– If no updates are found, the message box closes and a “No updates available” message 
displays. Select the message to close it.

– If updates are found, they will automatically begin to download (Figure 15-5).

Figure 15-5 Typical - Downloading update window

NOTE:
i The percentage status bar may not always be displayed while downloading (Figure 15-5).

3. During an active download, two options are available:

– Minimize—closes the message box. The download continues as a background task and 
the diagnostic tool can be used normally. Select Show Progress from the SST icon menu 
at any time to reopen the message box and check the status of the download.
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– Cancel—stops and cancels the download and closes the message box. If you select 
Cancel, and choose to re-start the download again, the download will start from the 
beginning. 

4. Once the download completes, it must be installed. See the applicable instructions for  
Installing Software Updates on page 169 or Installing Software Upgrades on page 171.

For SST program updates (only) - if you have the Automatic Update setting ”on”, the update 
will be installed automatically. See Automatic Update setting in Basic Operation on page 165 
for additional information.

If you have the Automatic Update setting “off”, the SST program must be manually 
installed. See Installing Software Updates on page 169.

NOTE:
i If the Internet connection is interrupted during a download, the download is suspended and a 

“network unavailable” message displays. The message disappears and the download resumes 
automatically once the Internet connection is restored.

15.3   Installing Software Updates
When a software update is ready for installation, an installation update message will appear 
(Figure 15-6). You can select the message or the SST icon from the system tray at anytime to start 
the software update installation process. 

Figure 15-6 Typical update installation message

NOTE:
i If applicable, before installing a software update, have your Scan Module and USB cable 

available. The software update may include Scan Module firmware updates that need to be 
installed. 

z To install a software update:

1. Select the software update available message (Figure 15-6), or the SST icon from the system 
tray.

A software update installation window will display (Figure 15-7).
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Figure 15-7 Typical update installation window

2. Select an installation option to continue:

– Install Now—starts the software update installation. Proceed to step 3.

– Install Later—closes the message. The message will reappear at a later time as a 
reminder. 

NOTE:
i If Install Later is chosen, you can select the SST icon from the system tray to restart the 

installation at anytime.

3. Close the ShopStream Diagnostic Suite application. The ShopStream Diagnostic Suite 
should remain closed until the software installation has completed.

4. Follow the on-screen instructions to complete the installation.

5. After the installation is complete, open the ShopStream Diagnostic Suite application.

6. If applicable, select Scanner from the Home Screen. If a Scan Module firmware update has 
been received, a “Scan Module firmware update” message will display. Proceed to Updating 
Scan Module Firmware on page 63. 

– If the Scanner opens normally and no update message is displayed, proceed to step 7.

7. Turn the diagnostic tool off, then turn it on (re-boot). 

8. From the toolbar, select Menu  > HELP > Version Info to confirm the new version number is 
installed.
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15.4   Installing Software Upgrades

NOTE:
i If applicable, before installing a software upgrade, have your Scan Module and USB cable 

available. The software upgrade may include firmware updates that need to be installed to the 
Scan Module. 

z To install a software upgrade:

1. Select the software upgrade available message (Figure 15-8), or the SST icon from the 
system tray.

Figure 15-8 Typical upgrade installation message

An upgrade installation window will display (Figure 15-9).

Figure 15-9 Typical upgrade installation window



172

ShopStream Update Tool (SST) Installing Software Upgrades

2. Select an installation option to continue:

– Upgrade Detail—opens a PDF file describing the details of the software upgrade, 
including any accessories that may be required.

– Install Now—starts the software upgrade installation. Proceed to step 3.

– Install Later—closes the upgrade message. The upgrade available message reappears 
at a later time as a reminder.

NOTE:
i If Install Later is chosen, you can select the SST icon from the system tray to restart the 

installation at anytime.

3. Close the ShopStream Diagnostic Suite application. The ShopStream Diagnostic Suite 
should remain closed until the software installation has completed.

4. Follow the on-screen instructions to complete the installation.

5. After the installation is complete, open the ShopStream Diagnostic Suite application.

6. If applicable, select Scanner from the Home Screen, if a Scan Module firmware update has 
been received, a “Scan Module firmware update” message will display, proceed to Updating 
Scan Module Firmware on page 63

– If the Scanner opens normally and no update message is displayed, proceed to step 7.

7. Turn the diagnostic tool off, then turn it on (re-boot). 

8. From the toolbar, select Menu  > HELP > Version Info to confirm the new version number is 
installed.
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This section covers how to care for your diagnostic tool.

16.1   Cleaning the Touch Screen
The touch screen can be cleaned with a soft cloth and alcohol or a mild window cleaner.

IMPORTANT:
Do not use any abrasive cleansers or automotive chemicals on the touch screen.

16.2   Calibrating the Touch Screen
The sensitivity and accuracy of the touch screen should be calibrated before you begin using your 
diagnostic tool. Adjustments can be made to the touch screen calibration to maintain your 
personal settings. The touch screen can also be set to recognize the stylus being held in place for 
five seconds as a right-click of a mouse. Both procedures are explained below.

z To calibrate the touch screen:

1. From the Windows toolbar select Start > All Programs > Hampshire TSHARC Control 
Panel to open the touch screen dialog box (Figure 16-1).

Figure 16-1 Sample Hampshire TSHARC Control Panel window

2. Select the Calibration tab.

3. Select Configure to open the Calibration Options dialog box.

4. Check 20% in the Offset field on the right-hand side of the dialog box, scroll down and select 
20 Point Calibration on the left-hand side of the screen.
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5. Select OK to close the Calibration Options dialog box.

6. Select the Calibration Target to begin the calibration process.

7. As targets appear on the screen, select the center of the target with the tip of the stylus. Hold 
the stylus on the target until the release instruction appears.

8. Select Accept to save the settings after selecting all of the targets.

9. Select Apply to implement the new settings.

10. To make additional adjustments, select other tabs and follow the screen instructions.

11. Select OK to close the Control Panel dialog box.

IMPORTANT:
If the touch screen is severely out of calibration use a USB mouse, rather than the stylus, to 
perform the calibration.

z To set the touch screen for a right mouse click:

1. From the Windows toolbar select Start > All Programs > Hampshire TSHARC Control 
Panel to open the touch screen dialog box.

2. Select the Click Settings tab.

3. Select the Enable Right Click check box.

4. Set both the Right Click Area and Right Click Delay sliders to the middle of the bars.

5. Select Apply to implement the new settings.

6. Select OK to close the Control Panel dialog box.

16.3   Cleaning and Inspecting the Diagnostic Tool
When using the diagnostic tool, make sure to do the following:

• Check the housing, wiring, and connectors for dirt and damage before and after each use.

• Inspect the fan filter. Replace the filter if it is torn, severely dirty, or otherwise damaged.

• At the end of each working day, clean the housing, wiring, and connectors with a clean damp 
cloth.

IMPORTANT:
Do not use any abrasive cleansers or automotive chemicals on the diagnostic tool.

16.4   Fan Filter Service
The fan filter should be periodically replaced to ensure an unrestricted source of cooling air to the 
diagnostic tool. Replacement intervals vary depending upon tool use and environment, replace as 
needed.

z To replace the fan filter:

1. Clean off any dirt from the area around the filter.

2. Remove the old filter.

3. Install the new filter.
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16.5   Battery Pack Service
Follow all safety guidelines when handling the battery pack.

Risk of electric shock.
• Prior to recycling batteries, protect exposed terminals with heavy insulating tape to 

prevent shorting.
• Disconnect all test leads and turn diagnostic tools off before removing end grips.
• Do not attempt to disassemble the battery or remove any component projecting from or 

protecting the battery terminals.
• Do not expose the diagnostic tool or battery pack to rain, snow, or wet conditions.
• Do not short circuit the battery pack terminals.
Electric shock can cause injury.

Risk of explosion.
• The Lithium battery is factory replaceable only, incorrect replacement or tampering with 

the battery pack may cause an explosion.
Explosion can cause death or serious injury.

16.5.1 Battery Pack Safety Guidelines

IMPORTANT:
The battery pack contains no user serviceable components. Tampering with the battery pack 
terminals or housing will void the product warranty.

Keep the following in mind when using and handling the battery pack:

• Do not short circuit battery pack terminals.

• Do not immerse the diagnostic tool or battery pack in water, or allow water to enter the 
diagnostic tool or battery pack.

• Do not crush, disassemble, or tamper with the battery pack.

• Do not heat the battery pack to over 100°C (212°F), or dispose of it in a fire.

• Do not expose the battery pack to excessive physical shock or vibration.

• Keep the battery pack out of reach of children.

• Do not use a battery pack that appears to have suffered abuse or damage.

• Charge the battery pack in the appropriate charger only.

• Do not use a battery charger that has been modified or damaged.

• Use the battery pack for the specified product only.

• Store the battery pack in a cool, dry, well ventilated area.

NOTE:
i The battery pack should be used within a short period of time (about 30 days) after charging to 

prevent loss of capacity due to self-discharging.

If long-term storage of the battery pack is necessary, it should be stored in a in cool, dry, well 
ventilated place with a 30 to 75 percent state of charge to prevent loss of characteristics.
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To prolong the life of your battery, power off the diagnostic tool when it is not in use. The diagnostic 
tool has a built in charger that recharges the battery on demand whenever it is connected to a 
power source. A Smart Battery Charger, which prolongs battery life and improves performance, is 
available as an option.

The optional Smart Battery Charger ensures maximum performance by cycling the battery to a 
complete discharge state, then slowly drawing it up to a full charge. This over-night charging cycle 
is highly recommended for units that are subjected to heavy usage.

16.5.2 Replacing the Battery Pack

If the battery pack no longer holds a charge, contact your sales representative to order a new one.

IMPORTANT:
Replace the battery pack with original Snap-on replacement parts only.

z To replace the battery pack:

1. Remove the right-side handgrip from the diagnostic tool.

2. Depress the lock tab on the back side of the battery pack.

3. Slide the battery pack clear of the diagnostic tool.

4. Fit the new battery pack into the slot.

5. Install the handgrip.

16.5.3 Disposing of the Battery Pack

Always dispose of a lithium-ion battery pack according to local regulations, which vary for different 
countries and regions. The battery pack, while non-hazardous waste, does contain recyclable 
materials. If shipping is required, ship the battery pack to a recycling facility in accordance with 
local, national, and international regulations. 

• United Kingdom—Electrical Waste Recycling Company at http://www.electricalwaste.com

Products bearing the WEEE logo (Figure 16-2) are subject to European Union regulations.

Figure 16-2 sample WEEE logo

NOTE:
i Always dispose of materials according to local regulations.

Contact your sales representative for details.
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16.5.4 Battery Pack Calibration

The battery pack contains a micro controller that monitors the battery pack characteristics and 
maintains an internal “fuel gauge”. The internal fuel gauge may lose some accuracy after many 
cycles of partial discharge and charge. Should this happen, the fuel gauge can be calibrated with 
the following procedure:

z To calibrate the battery pack fuel gauge:

1. Fully charge the battery pack.

2. Fully discharge the battery pack at a steady rate.

IMPORTANT:
The battery must be completely discharged! Operate the diagnostic tool until it shuts down by itself 
due to a lack of power. Continue operating the tool when the “low battery” warning displays, do not 
begin charging until after the tool has automatically shut down.

3. Fully charge the battery pack.

NOTE:
i It is not recommended to perform the calibration procedure more than once within 30 days.

The optional Smart Battery Charger automatically cycles the battery pack to calibrate it.

16.6   System Restore
The diagnostic tool contains Snap-on System Restore software that returns the tool to original 
factory condition following a catastrophic failure. Use the procedure below to restore the system if 
your diagnostic tool does not start the Windows operating system, or if the hard disk drive or other 
system files have become corrupted.

IMPORTANT:
All data on the hard disk drive C is erased during a system restore. If at all possible, make a back 
up copy of any personal or saved data before proceeding.

It is highly recommended that the diagnostic tool be connected to an AC power source when 
performing a system recovery. If AC power is not available, make sure the internal battery pack is 
fully charged.

z To restore the system software:

1. With the diagnostic tool turned off, connect an external keyboard to the USB jack on top of the 
diagnostic tool.

2. Select and hold the Left ALT key on the keyboard, then press the Power button.

A dialog box warning that all data on drive C will be deleted and replaced with original factory 
data displays.

3. Select OK to proceed with the restore, or Cancel to abort.

The system restore begins and the time remaining until completion displays if OK is selected. 
The operation typically takes from 10 to 20 minutes.
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4. When the “finished successfully” message displays, select OK to reboot the system.

The Windows system reseal program automatically runs on start up and a dialog box displays. 
Once the reseal completes, the dialog box closes, Windows starts, and the diagnostic tool is 
ready for use.

If you receive an error message while starting the software, the license key may need to be 
updated or replaced. Contact your sales representative or Customer Care.

NOTE:
i After using the Snap-on System Restore software, the diagnostic tool is restored to original factory 

condition. In addition, if you have purchased and installed any of the “Bundle” updates, the most 
current Snap-on Bundle update will also be re-installed. However, any additional software that you 
installed will need to be reloaded onto the system after a System Restore. Contact your sales 
representative or Customer Care for additional information.

16.7   Scan Module
When using the wireless Scan Module, make sure to do the following:

• Check the housing, wiring, and connectors for dirt and damage before and after each use.

• At the end of each working day, clean the housing, wiring, and connectors with a clean damp 
cloth.

IMPORTANT:
Do not use any abrasive cleansers or automotive chemicals on the Scan Module.

16.7.1 Replacing the Protective Handgrip

The soft protective handgrip that covers the outer edges of the Scan Module is easily replaced 
should it become worn or damaged. Contact your sales representative for replacement parts.

z To replace the protective handgrip:

1. Disconnect the data cable, and any other cables, if attached to the Scan Module.

2. From the bottom of the Scan Module, gently lift up and out on one side of the handgrip to free 
it from Scan Module housing.

3. Repeat step 2 to loosen the other side of the handgrip.

4. Lift the handgrip off of the Scan Module housing.

NOTE:
i The handgrip tapers toward the front of the Scan Module housing. Make sure the replacement 

handgrip is correctly oriented before attempting to install it.

5. Fit the new handgrip over the top, data cable end, of the Scan Module housing.

6. With your fingers, work the new handgrip onto the Scan Module housing from top to bottom. 
Make sure the tabs on the handgrip fit into the grooves on the housing.
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